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the manuals distributed with an 
Apple product or in the media on 
which a software product is distrib
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purchased the software. In addition, 
Apple will replace damaged software 
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Apple's Media Exchange Program. 
While not an upgrade or update 
method, this program offers addi
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or more from the date of your 
original purchase. See your author
ized Apple dealer for program 
coverage and details. In some 
countries the replacement period 
may be different; check with your 
authorized Apple dealer. 

All IMPLIED WARRANTIES ON 
THE MEDIA AND MANUALS, 
INCLUDING IMPLIED WAR
RANTIES OF MERCHANTABIL
ITY AND FITNESS FOR A 
PARTICULAR PURPOSE, ARE 
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software and reviewed the docu
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PERFORMANCE,MERCHANT
ABILITY, OR FITNESS FOR A 
PARTICULAR PURPOSE. AS A 
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SOLD "AS IS," AND YOU THE 
PURCHASER ARE ASSUMING 
THE ENTIRE RISK AS TO ITS 
QUALITY AND PERFORMANCE. 

IN NO EVENT WILL APPLE BE 
LIABLE FOR DIRECT, INDIRECT, 
SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES 
RESULTING FROM ANY DEFECT 
IN THE SOFIWARE OR ITS 
DOCUMENTATION, even if advised 
of the possibility of such damages. 
In particular, Apple shall have no 
liability for any programs or data 
stored in or used with Apple 
products, including the costs of 
recovering such programs or data. 

THE WARRANTY AND REMEDIES 
SET FORTH ABOVE ARE EXCLU
SIVE AND IN LIEU OF All 
OTHERS, ORAL OR WRITTEN, 
EXPRESS OR IMPLIED. No Apple 
dealer, agent, or employee is 
authorized to make any modifi
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this warranty. 

Some states do not allow the 
exclusion or limitation of implied 
warranties or liability for incidental 
or consequential damages, so the 
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you may also have other rights 
which vary from state to state. 
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Preface 

The Inter.PollTM Network Administrator's Utility is a software tool 
that searches for and reports on the active devices-such as 
workstations, printers, and file servers- connected to an 
AppleTalk(!!) network system. The information reported by 
Inter.Poll can help you to locate, analyze, and solve 
communication problems on your network. Inter.Poll can: 

o display customizable listings of network zones, connected 
networks, and active network devices 

o verify the connection status of any part of a network or internet 
(multiple networks joined by bridge deVices), to help respond to 
user problem reports 

o localize possible sources of trouble and provide troubleshooting 
guidelines to pinpoint problems 

o query active workstations in an AppleTalk network system for a 
report of currently running system software versions 

o test the integrity and response time of the network path to an 
individually targeted network device 

ix 
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Intended audience 
The Inter.Poll software and this manual have been designed for use 
by: 

o the administrator of a small to medium-sized AppleTalk network 
system (7-32 nodes) who wants to plan for growth and adopt 
sound network management practices at an early stage 

o the administrator of a medium-sized AppleTalk network system, 
possibly at the point of restructuring into an internet, whose 
network needs call for regular maintenance and diagnostics 

o the administrator of a large AppleTalk internet, where diagnostic 
tools are essential and troubleshooting is a significant part of the 
job 

The technical contents of this manual are written for the reader with 
knowledge at the level of an experienced user or network 
administrator. Some of the material is fairly technical, but no new 
concepts are introduced without explanation. 

Inter.Poll and this manual also provide the means for preventive 
maintenance, to help detect network trouble before users 
experience problems. 

How to use this manual 
This manual begins with basic concepts and proceeds to explicit 
instructions. This means that an experienced network administrator 
may spend less time on introductory chapters and move quickly to 
operating instructions. However, it's important for everyone using 
Inter.Poll to become familiar with AppleTalk concepts and terms, 
such as zones and internets, as these are central to understanding 
the use of Inter.Poli. 



Follow the procedure below to make sure you get the most out of 
your Inter.Poll program: 

• Step 1: Read the introduction to Inter.Poll in Chapter 1. Readers 
new to AppleTalk should take the time to study "AppleTalk 
Concepts and Terminology," to become familiar with AppleTalk 
network systems and how their component concepts are 
interrelated. 

• Step 2: Follow the installation instructions in Chapter 2, and 
read "How Inter.Poll Works," the description of program 
capabilities. Then proceed to step 3 before trying to use 
Inter. Poll. 

• Step 3: Create a graphic map of your network layout as described 
in Chapter 3. 

• Step 4: Perform some trial network searches to familiarize 
yourself with Inter.Poll, using the reference information in 
Part II. 

• Step 5: Proceed to use Inter.Poll for network maintenance, 
referring to the troubleshooting guide in Chapter 4 as needed. 

System requirements 
Inter.Poll and the accompanying Responder workstation 
identification software require the following hardware and system 
software: 

Hardware 

Inter.Poll may be operated on any of the following Macintosh® 
computers: 

o Macintosh Plus 

o Macintosh SE 

o Macintosh II 

Inter.Poll cannot be operated on any of the following: 

o Macintosh with 128K of memory 

o Macintosh with 512K of memory 

o Macintosh XL 

System requirements xi 
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The Responder software, which is installed on all network 
workstations, will operate on any Macintosh computer having 512K 
of memory or more, including the Macintosh 512K and the 
Macintosh XL. Other workstation types, such as Apple® II and 
MS/PC-DOS computers, have responder functions built into their 
AppleTalk network software. 

Software 

The Macintosh workstation running Inter.Poll must have a System 
file version of 4.1 or higher. Inter.Poll will display an alert message 
if the System file does not satisfy this requirement. 

Each Macintosh workstation running the Responder software must 
have a System file version of 3.2 or higher. 

Associated documents 
The following manuals available from Apple Computer, Inc. 
provide additional information about AppleTalk networks: 

o The LoealTalk Cable System Guide is a brief reference guide to 
LocalTalk™ cabling, hardware, and installation. Use it to help in 
the initial setup of your network, and as a basic introduction to 
LocalTalk networks. 

o Inside AppleTalk is the technical reference manual that explicitly 
describes AppleTalk network protocols. This document is 
available from the Apple Programmer's and Developer's 
Association (APDATM). 

o EtherTalk User's Guide provides installation and operation 
gUidelines for those using EtherTalk™ in their AppleTalk network 
system. 
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Network troubleshooting 
computer networks are transforming the way we work. Instantaneous 
information sharing-between offices or across continents-has 
demonstrated the power of individual human efforts joined 
together by technology. But in any technology the joining of 
multiple parts can introduce new complexity, and calls for 
thoughtful planning, monitoring, and maintenance. This 
maintenance process, network troubleshooting, is what 
Inter.PollTM is all about. 

Network troubleshooting involves more than just waiting for users to 
report problems and then responding. It's essential to develop a 
plan of how things should work, and to make sure they keep working 
according to that plan, before proceeding to the "firefighting" 
mode of network troubleshooting. 

Network administration with Inter.Poll begins with the strategic 
planning of network layout, continues with regular maintenance to 
assure network integrity, and ultimately-when problems do 
occur-involves diagnostic testing and interpretation. Use 
Inter.Poll: 

o to look for devices "missing" from the network, when users report 
trouble 

o to help keep track of the number and location of devices in large 
intemets undergoing frequent changes 

o to test network regions where users report poor response or data 
loss, to help identify the location of breakdown 

o to run periodic tests of response at selected network points, to 
assure continued operating performance 

look for simplicity first 
Network users often overestimate the complexity of network 
problems. The connections and routing functions-introduced by 
the network suggest to them behind-the-scenes activities that can 
cause problems with hidden sources. Yet the best approach to 
maintaining a network is to understand its simplicity. 

4 Chapter 1: Introduction to Inter. Poll 



Imagine your network as a home plumbing system connecting all 
the sinks and tubs in a house. The water pipes represent network 
cable, and water flows through the pipes like data through the 
network. If the water stopped running at one faucet while all the 
others continued working, the logical place to check the pipes would 
be right at that problem sink. If, on the other hand, the hot water 
throughout the house suddenly became rusty, it would be natural to 
check the lines at the source: the hot water heater, or the pipe 
leading from the heater to where it branches toward individual 
outlets. 

When problems arise in a network system, the diagnostic process 
is similar. You begin by isolating the location or locations where 
symptoms can be seen. Then you follow a list of guidelines that 
check for the source of the fault in those locations. Inter.Poll is 
simply a tool that enables you to perform those checks more 
efficiently, from one central location. The troubleshooting 
guidelines to use in applying Inter.Poll are detailed in Chapter 4. 

Network configuration planning 
An efficiently operating network that will serve long-term needs 
must begin with a well thought-out, flexible configuration plan. 

The foundation of your network configuration plan is a network 
map. The map creation process is addressed in detail in Chapter 3. 
Specific guidelines to aid in planning your network can be found in 
this manual's Appendix B, "Network Configuration Guidelines." 

The following considerations will determine the network plan: 

o user locations and distances between devices 

o analysis of user activities (for example, printing, file sharing, 
and electronic mail) 

o departmental groupings/network zones 

o location of shared resources (LaserWriter@, AppleShare@, 
LaserShareTM , and so on) 

o balanced areas of high and low traffic 

o single local network versus multiple linked networks 

o network cable medium (such as LocalTalk™ or EtherTalk™) 

o directly connected networks versus long-distance telephone links 

o cable distribution facilities (conduits , ducts) 

Network configuration planning 5 



Factors including the number of users to be connected, the type of 
network traffic they will generate, and the physical area to be 
covered by the network will guide the decision whether to form a 
single local network or link multiple independent networks together. 
Likewise, applying the AppleTalk@ concept of network zones 
(described in the next section) will enable the logical definition of 
groups of users who will share network services, such as AppleShare 
file servers and LaserWriter printers. 

Another key consideration will be which type of cable medium to 
use, whether LocalTalk or EtherTalk, for example. 

The concepts described in the next section will give you a better 
understanding of how an AppleTalk network system operates, to 
help in your administration and troubleshooting efforts. 

AppleTalk concepts and terminology 
An AppleTalk network system uses standardized communication 
protocols, or systematized rules of data transmission. These 
protocols manage the way data traveling on the network is 
addressed, sent, received, and read by network devices. 

The AppleTalk terminology defined below will be used frequently 
throughout the Inter.Poll documentation. The AppleTalk protocols 
themselves are described in Appendix A. 

Cabling systems and speed 
AppleTalk is a network system capable of operating over several 
types of cabling systems at a wide range of speeds. While all 
AppleTalk networks use the same AppleTalk protocols, they do not 
all use the same cables and connections. 

The design of AppleTalk allows customers to select the cabling 
systems that best suit the needs of their installation, while retaining 
the same AppleTalk services and interface. For moderate traffic 
requirements, LocalTalk is a low-cost cabling system with medium 
throughput that connects to the printer port of any Macintosh 
computer. EtherTalk uses the higher-performance cables of an 
Ethernet network and connects to special interface cards in certain 
Macintosh computers. 

Using bridge devices, network segments of different cabling types 
can be connected together as needed. 

6 Chapter 1: Introduction to Inter. Poll 
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Packets 
Data is transferred in AppleTalk network systems in prescribed 
formatted units called packets. Packet formatting appends control 
information to the data, such as the addresses of the sender and 
destination. 

AppleTalk addressing 

Nodes and node 10 

A node is a single addressable entity connected to an AppleTalk 
network. A node on an AppleTalk network may be a workstation, 
such as a Macintosh® II, or a network server, such as a file server. 

Each node has an associated identification number, called the 
node 10. This is the address used by AppleTalk protocols in 
delivering data to the node. ID assignment is performed 
dynamically by the AppleTalk software at the time of device startup; 
no permanent ID is fixed to any device. In this way, nodes may be 
moved between networks without the risk of producing ID conflicts. 

Sockets 

Sockets are individual addresses within network nodes. Sockets 
make network addressing more explicit than node IDs, allowing 
multiple addresses to be specified within a given device. 

In this way, two or more network servers, such as a LaserWriter 
spooler and an AppleShare file server, can coexist in the same 
Macintosh node without any network addressing conflicts. 

Named and unnamed devices 
A named device is any device that is registered on the AppleTalk 
network by a user-defined name. Registration of a Macintosh 
workstation is performed by the ResponderTM software, which 
identifies the device during Inter.Poll searches. Responder uses the 
name entered in the Macintosh Chooser as the name of the 
workstation. 

AppleTalk concepts and terminology 7 



Network servers such as a LaserWriter or AppleShare server 
automatically register their names and therefore do not need to run 
the Responder. 

An unnamed device is any device connected to the AppleTalk 
network that has not registered a name (for example, workstations 
running non-Apple network software). These devices can generally 
be detected by Inter.Poll, but not identified by device type or 
name. 

Internets 
AppleTalk supports the interconnection of multiple AppleTalk 
networks of any cabling type into an internet. A network 
number is assigned to each connected network on the internet for 
addressing purposes. A socket's AppleTalk internet address 
consists of a socket number, the node ID of the node in which the 
socket is located, and the network number of the network to which 
the node is connected. 

Zones 
A zone is an arbitrarily defined grouping of AppleTalk networks that 
may be used to identify a subset of the total internet. Zones facilitate 
the departmental grouping of users, and the sharing of services such 
as LaserWriters across the internet. The usefulness of zones is 
illustrated by the Macintosh Chooser, which presents to the user 
only those printers and shared services available in the zone 
selected by the user. 

There is no size limit to a zone; it can be defined to contain one 
network, several, or the entire internet. However, zones may not 
overlap to share any networks (and thus nodes) in common. 

AppleTalk bridges 
The linking of an AppleTalk network to one or more additional 
networks is accomplished with the use of a bridge. A bridge device 
has multiple communication ports, and is capable of routing data 
to other bridges and devices on the internet. 
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Bridges are also known as internet routers. They perform a routing 
function by forwarding a data packet from its sending node through 
a chain of bridges until it reaches the AppleTalk network on which its 
destination node is located. 

Bridge-resident logic includes protocols that perform the packet 
routing, maintain network routing information, and perform other 
functions detailed in AppleTalk protocol documentation (see 
Inside AppleTalk). 

The following bridge configurations are supported: 

Local bridge 

A local bridge is used for the direct interconnection of two or more 
networks in close proximity. 

;====0-{ Bridge f-O======< 

1

1""""1 -
= 1

1"""" 1 -
= 

III -
= 

Remote bridge 

Where remote networks are interconnected via long-distance links 
(such as modems and telephone lines), each network is connected 
to an AppleTalk bridge, which in tum is connected to the datacom 
link. This configuration is called a remote bridge. 

Datacom 
link 

>===:::oj Bridge _---_I BrIdge f-o===~ 

1"" 11 -
= 
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1
1 ' 1 -
= 

1
1"""1 -
= 

Backbone bridge 

A backbone network topology supports multiple bridges sharing a 
central backbone network, allowing networks to be linked in a 
nonserial manner. This minimizes the path between any two points 
on the internet and thereby improves performance. 

F====O-j BrIdge Bridge I-D====< 

>=====D-! BrIdge 

1""" 11 -
= 

1""""11 -
= 

Gateways 
A gateway is a device that connects an AppleTalk protocol-based 
network system to a non-AppleTalk protocol system. The gateway 
serves as a translator between the protocols of the two connected 
networks. Inter.Poll searches do not extend across gateways into 
foreign protocol networks. 

Hops 
A hop, signifying "one bridge away," is a unit count between 
networks on the internet. For example, a network device located on 
a network separated from yours by three bridges (in the shortest 
route) would be three hops away. 

AppleTalk protocols support a maximum of fifteen hops in the path 
from a packet's sender to its destination node. 
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Network troubleshooting 
computer networks are transforming the way we work. Instantaneous 
information sharing-between offices or across continents-has 
demonstrated the power of individual human efforts joined 
together by technology. But in any technology the joining of 
multiple parts can introduce new complexity, and calls for 
thoughtful planning, monitoring, and maintenance. This 
maintenance process, network troubleshooting, is what 
Inter.PollTM is all about. 

Network troubleshooting involves more than just waiting for users to 
report problems and then responding. It's essential to develop a 
plan of how things should work, and to make sure they keep working 
according to that plan, before proceeding to the "firefighting" 
mode of network troubleshooting. 

N~twork administration with Inter.Poll begins with the strategic 
planning of network layout, continues with regular maintenance to 
assure network integrity, and ultimately-when problems do 
occur-involves diagnostic testing and interpretation. Use 
Inter.Poll: 

o to look for devices "missing" from the network, when users report 
trouble 

o to help keep track of the number and location of devices in large 
intemets undergoing frequent changes 

o to test network regions where users report poor response or data 
loss, to help identify the location of breakdown 

o to run periodic tests of response at selected network points, to 
assure continued operating performance 

Look for simplicity first 
Network users often overestimate the complexity of network 
problems. The connections and routing functions introduced by 
the network suggest to them behind-the-scenes activities that can 
cause problems with hidden sources. Yet the best approach to 
maintaining a network is to understand its simplicity. 
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This chapter describes the installation and operation of the 
Inter.Poll program. Follow the installation procedure and read the 
rest of the chapter to familiarize yourself with Inter.Poll. Then go on 
to Chapter 3 and follow the directions to produce your network map 
before proceeding to use Inter.Poll. 

Select a network administrator 
Installing and operating Inter.Poll will require the selection of a 
network administrator who is responsible for maintaining the 
network. The general responsibilities of the network administrator 
will include some or all of the following: 

o participate in planning the network system layout, including the 
design of network and zone boundaries in internets 

o assign and configure network numbers and zone names in bridge 
devices 

o coordinate the addition, removal, and relocation of devices on 
the network 

o develop and maintain a current map of the network layout and 
device locations 

o coordinate the selection and implementation of network 
resources, such as file servers and electronic mail facilities 

o perform regular preventive maintenance to help assure 
continuous network operation 

o maintain control of system software version compatibility 
among network devices 

o troubleshoot network problem reports, locate malfunctions, and 
perform repairs 

If a network administrator is not already deSignated for your 
network, it's recommended that you choose one at this time. 
Inter.Poll should be installed on the administrator's workstation 
and generally operated from that location (although network 
problems affecting this workstation may at times require Inter.Poll 
to be run from another location) . 

• ) Note: Refer to "System Requirements" in the Preface of this 
manual for information on the hardware and software 
environments that will support Inter.Poll. 
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The network administrator must be familiar with Macintosh 
operation, and will benefit from prior training in hardware, 
software, or data communication, but is not required to have any 
specific technical background. Once assigned, the position should 
remain with one individual if possible. Network problems are best 
solved by someone with continuous access to the network's 
configuration, status, performance history, and so on. (It's 
recommended, however, that you train an alternate who can be 
responsible for the network when the administrator is unavailable.) 

Installlnter.Poll 
The Inter.Poll program and supporting software are provided on 
three startup disks, each containing the following files: 

• Administration disk (800K): 

o the Inter.Poll program file 

o the MacDraw Network Map file 

o a System Folder 

• Node Installation disk (800K version): 

o the Responder node identification software 

o the Installer program 

o a System Folder 

• Node Installation disk (400K version): 

o the Responder node identification software 

o the Installer program 

o a System Folder 

Follow the instructions below to install Inter.Poll on your network. 

Step 1: Install the Inter.Poll program 
First, install the Inter.Poll program on the network administrator's 
workstation by copying it onto the system's startup disk. You may 
place the program file in any convenient folder, or keep the 
Inter.Poll icon directly accessible on the Macintosh desktop. 
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Step 2: Install the Responder software 
Next, the Responder node identification software must be installed 
on the administrator's workstation and all other Macintosh nodes 
on the network. This software enables Inter.Poll to recognize the 
device and acquire various identifying data when searching the 
network. Responder will register the User Name currently in the 
Chooser desk accessory as the Macintosh workstation's AppleTalk 
device name. 

Follow the instructions below to install Responder on each 
Macintosh workstation. (A 400K version of the Node Installation 
disk is provided to allow you to install Responder on older 
Macintosh workstations requiring this format.) 

D Insert the appropriate Node Installation disk and open the 
Installer file. 

D When the Installer dialog box appears, select the workstation's 
startup disk as the disk on which to install Responder. 

D Select Responder as the resource you want to install and click the 
Install button. 

D Once the installation procedure is complete, quit the Installer 
and eject the Inter.Poll Node Installation disk. 

D Restart the system. 

Installer 

RI'~pondl'r III 1.01 :!1 HD 

Ijp!:1 

Driue 

Install ) 

Help 

Quit 

,·s Installation wilileaue 1149K free on this disk; 
~':. Remoual will free zero K. 

16 Chapter 2: Getting Started 



The Responder software will be installed in the workstation's System 
Folder. If no name is currently registered in the workstation's 
Chooser desk accessory, a dialog box will appear during the 
installation procedure and request that a name be entered for 
device identification. 

LaserWriters, file servers, and other network services visible in the 
Macintosh Chooser are named devices, and do not require the 
Responder software for identification. 

Important Since Responder registers the User Name entered in the 
Macintosh Chooser as the device name, it is strongly advised 
that users be Instructed not to change the User Name 
arbitrarily. This way names will remain consistent on device lists, 
and correspond to network maps. 

Step 3: Copy the Network Map file 

A graphic tools file named Network Map is provided with Inter.Poll. 
This file contains symbols that can be used to construct a network 
map with the MacDraw application. Copy this file into any 
convenient folder, and refer to Chapter 3, "Network Mapping," for 
instructions on creating the map. 

Inter. Poll and network devices 
Inter.Poll finds named devices on the internet using the services of 
AppleTalk's Name Binding Protocol, or NBP (defined in Appendix 
A and described in detail in Inside AppleTalk). To be visible to 
NBP, a device can be named in one of three ways: 

o Macintosh workstations are named by the Responder software, 
using the name entered in the Chooser. 

o LaserWriters, AppleShare servers, and other devices visible via 
the Macintosh Chooser give themselves names using NBP. 

o Other network devices may have name registration capabilities, 
as defined in the user manual of the particular device. 

Additional devices that can be named by one of the above methods 
include the Apple® IIe and Apple IIGS®, MS/ PC-DOS computers 
(with the LocalTalk PC Card), and Digital Equipment Corporation 
VAX systems (running AppleTalk for VMS software). 
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Inter.Poll can also detect unnamed devices on the network, 
although no specific information is reported about these devices. 
Unnamed device searches can be used to check the connection 
status of unnamed network devices. 

First look: An Inter.Poll example 
What follows is a brief example of Inter.Poll at work. The network 
problem chosen to illustrate the program's capabilities is simple 
and quite common: a network break caused by a disconnected 
cable. 

The following diagram is the network map for our sample network. 
This map should show the network layout and-if the network size 
permits this level of detail-indicate the location and name of each 
connected device. 
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A network problem report 

In our example, network user Betty comes to you, the network 
administrator, to report a problem. She can no longer see the 
network's LaserWriter in her Macintosh Chooser window, and 
consequently cannot select it to print her documents. 

At this point you could proceed in one of two ways: 

o tum to Inter.Poll for a listing of all active devices on the network 

o begin with spot-checks at Betty's workstation and at the 
LaserWriter 

Without Inter.Poll, the process could also involve visual checks at 
each connecti9n point between the two devices. 

Let's tum directly to Inter.Poll. 

Start Inter.Poll and begin a search 

On startup, Inter.Poll displays the Network Search window, shown 
below, which allows you to specify different types of device lookups. 
For a standard search of your entire network, you would simply 
accept the program's default settings by pressing Return or clicking 
the Start button to begin the device search. 

Network Search 

·Selec t Zone(s):........ .. Search Time :· 

~pllroldulc\~MIII.nlll.g·.m·.·n\··~19~:;:: '. ' 
PUblications 

~ l o Continuous 
Total Zones : 44 

@ All Named Deuices 

· .. Select Sorting:· 

I Net 

@ Ascending 
o Descending 

........ , Deuices Matching: .............................................................................................................. ',;::::::::==:::::::: : 

M ~~ t· , : Nel ...................... ... . ] 'Ji th ·, .............. ... .................................................. ,r ..... g'j 

. Search Criteri i ........ ... ............. .............. .. .... ......................................................... ... ................... ............. , 

Sear-ching for All Devices 

in Zone : Nets- R-Us 

fldd 

[ I h~ l\r Ill! ] 

[ Cdfl(f'! 1 
n Start J) 
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The device list 
The network search causes the Inter.Poll device list to be displayed. 
This list includes only active devices-those that are connected and 
turned on-and, unless otherwise specified at the time the search is 
performed, lists only devices identified by an AppleTalk name. 

In our example, the device list would look like this: 

Status: 

Searching for A 11 Devices 

ZonE' : Product Management 
Total Entries : 7 

. Het INode \Name 

273 10 39 Oarryl 
273 10 5 1 John 
27310 82 Belly 
273 10 11 3 James 
273 10 11 7 Fel i x 
273 10 12 1 Fred 
273 10 131 Server 

Deuice List 

Clear 1 n Start n 
Search Time : 2 Min 30 Sec 

Search Time (90) 
~ffff/u////ff$ffM0Wh%W/A1 
I I I 
o 50 100 

\ Type 

Mac in t osh P l us 
MS-OOS 3 .2 
Macintosh Plus 
Ma c: intosh I I 
App le ll GS 
Mac in t osh P l us 
AFPSe rver 

\2one 

Produc t Managemen t 
Produc: t Managemen t 
Produc: t Monogemen t 
Produc t Managemen t 
Produc t Managemen t 
Product Management 
Produc t Management 

• 

If your network were so small that you knew the name and location of 
each device by heart, this listing alone-without the network 
map-could reveal which devices were missing. 

However, in most cases, you would want to compare the list with a 
reference showing how your network should look with all devices in 
place: the network map. 
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The network map 
Now, refer back to the network map. This map shows our sample 
network with all nodes and devices in place. 

Compare the map with the device list to determine which devices, 
if any, are missing from the list. 

It's evident now that more than just the LaserWriter is being 
affected. Two other workstations, Robert's and Susan's, are also 
missing from the list, in addition to the LaserWriter. Betty's 
workstation, however, is listed as active on the network. 

Locating the break 
What does this information tell you about the source of the network 
problem? Most likely, if the break were located at the LaserWriter, 
Robert's and Susan's workstations would have no reason to 
disappear from the device list. 

Rather, the logical place to look for the break would be the network 
segment connecting the first missing device, Susan's, with the first 
listed device next to it, Darryl's. 

At this point, you would go to the actual location and follow the 
local troubleshooting gUidelines provided in this manual. These 
would include checking cables, connectors, software, and hardware 
at this segment of the network. 

More examples 
The above example-a network search to diagnose a simple break
is just one of many ways to use Inter-Poll. The program's capabilities 
are described in the overview that follows, and Chapter 4, "Network 
Maintenance and Troubleshooting," provides many practical 
examples of Inter-Poll network administration. 
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How Inter.Poll works 
Inter.Poll's program functions are described in the following 
sections. Specific instructions for program operation and for using 
each program option are provided in Part II, "Inter. Poll 
Reference. " 

Enter search criteria 
On program startup, the Network Search window is displayed, 
allowing you to enter search criteria. These criteria direct the 
program to look for nodes that satisfy the parameters of your 
search. 

Network Search 

,· Select Zone(s) ···· .............................. ,···Searcll Til ·· Select Sorting:····· 

Product Manageffieont F ~M;n @.OS. c I Net I 
Publications 

i ~. o Continuous 
@ Rscending 

T ota 1 ZonE's : 44 
o Descending 

o RII Named Deuices 
: .. @ Deuices MatChing: 

( Rdd 1 
11atch IType I Wi th U*tiii"imjlij"C lt1 [ Clear 1 

o [Hact Match @ Partial Match [ Clear RII 1 
···Search (I-iteria 

Net : Matches Any thing 
Name : Matches Any thirl9 [ Cml(pl 1 Typo : LASER'vIRITER , AFPSERVER 

in Zone- : Ne-ts R Us ([ Start ~ 
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The following search criteria may be specified: 

D network zone(s) in which to search 

D search duration in minutes and seconds, or continuous 
searching 

D sort key (by network number, by device name, and so forth) and 
sort order (ascending or descending) for the device list 

D listing of either all named devices or devices matching given 
parameters: 

D network number match 

D device name match 

D device type match 

D listing to include unnamed devices 

Display the device list 

Once search criteria have been entered, the network search is 
initiated, and Inter.Poll displays the Device List window. 

Status: 

Searching for All Devices 

Zone : Product Managem(>nt 
Total Entries : 7 

_ Het I Node l Name 

273 10 39 Darry I 
273 10 01 John 
27310 82 8etty 
2731 0 113 J ames 
27310 117 Fel ix 
273 10 12 1 Fred 
27310 13 1 Server A 

Deuice List 

Clear 1 I[ Start 1 
Search TimE' : 2 Min 30 Sec 

Search Time (%) 
Wffffff///ffM&A00W/A//$WM 
I I I 
a 50 100 

Type 

Hac in tosh PI us 
MS-DOS 3 . 2 
Mac in tosh P IIJ5 

Mac i ntosh I I 
App l e II GS 
Mac in t osh SE 
AFPSe rver 

Zone 

Produc t Manogemen t 
Produc t Managemen t 
Produc t Managemen t 
Produc t Managemen t 
Produc t Mcmagemen t 
Product Management 
Produc t Mcma gemen t 
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As Inter.Poll scans the network for devices meeting the search 
criteria, the results of the search are listed under the following 
column headings: 

• Net: the number of the network on which the device is connected 

• Node: the device's node ID 

• Socket: the socket number, or address, that is responding within 
the node (this column can be selected for display, but is not 
selected in the default listings) 

• Name: the device name registered by Responder or by the 
network application 

• Type: the device type (for example, the type "AFPServer" for an 
AppleShare file server) 

• Zone: the name of the AppleTalk zone to which the device 
belongs 

Format custom displays 
In the Device List window, the bar containing the display column 
headings is an interactive formatting tool. Its functions are 

o to move columns hOrizontally into any order 

o to remove any column from the display 

o to make any column wider or narrower to the limit of the 
available space 

By positioning the pointer in a heading label (such as "Node"), you 
can drag the label to any other position in the heading bar, or drag 
it off the page completely to remove the column from the display. 

Column width can be changed by dragging the label's edge to the 
desired width. 

Get system information 
One common type of network trouble stems from connected 
devices running conflicting versions of system software, specifically 
the Macintosh System file, Finder, or LaserWriter driver. User
reported symptoms in such cases include an inability to use network 
services, and possibly additional network malfunctions. 
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The network administrator can use Inter.Poll's System Information 
window to display the names of all active Macintosh workstations, 
together with a listing of the system software version each one is 
running. In this way any nonconforming workstation can be 
identified and its system software updated. 

Print or save device list 
In addition to displaying search results on the screen for immediate 
use, Inter.Poll allows you to save the currently displayed device list 
as a stored file, or send it to a printer. 

It's useful to maintain a printed list of networks and devices for 
reference. This list should be updated and reprinted as changes are 
made to the network. 

Test individual devices 
Any device on the network can be selected from the Device List 
window and targeted for individual testing using loopback tests. 
This is a troubleshooting tool that aids in localizing network faults by 
enabling test packets to be sent to a device, returned, and timed, 
checking for successful transmission. 

Net ; 27445 Node ; 8 
Device: Alan - Macintosh 11- nets-r-U5 

Using: 

o Echo Pkts 
Packets: 

Interval: o Printer Status Packets 

Timeout : Lll_._5 __ -,1 secs@SystemlnfoPackets 

Rcvd: 1 
Packets Sent: Left; ° 

Curr(>nt 

Lost : 0 
Total : 1 

Average Minimum Maximum 

K Start )) 

( Done) 

Hops Away I 2 2.00 2 2 I 
Delay (secs) '---0_.0_5 _____ 0._05 ____ 0_.0_5 ____ 0._05 __ --'. 

l Clear 

Status : 
Macintosh System FilE' Version 4 .2©Apple ComputE'r, Inc . 1983-87 All .. 
Macintosh Finder Version 6 .0 
LaserWriter: Version 5 .0, OctobE'r 1987 
Inter. Poll INIT Version: lOA 1 
AppleTalk Driver Version: 49 
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The following test packet types are provided: 

• Echo packets test link integrity between the Inter.Poll 
workstation and any active named device. 

• Printer packets test LaserWriter and lmageWriter$ printers, 
and return printer status information (printers do not respond to 
echo or system information packets). 

• System information packets query nodes running the 
Responder for a report of their system software versions . 

• :. Note: All three types of packets can be sent to any device, even if 
the particular device is unnamed, and therefore of unknown type 
(in this way the device type may sometimes be determined). 

For details on the use of loopback tests, refer to the description of 
the Device Test window in Part II of this manual. 
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A graphic map of your AppleTalk network system is a basic and 
necessary planning tool. It will help you design the initial network 
layout, and keep track of changes and additions to the network in an 
orderly way. 

The network map is also an essential part of your troubleshooting 
arsenal. For example, if Inter.Poll were to show that a given bridge 
or group of nodes were not responding, an examination of a map of 
the internet might reveal the obvious point where these might be cut 
off from the rest of the network. 

The importance of network maps becomes most evident as networks 
grow into internets and are complicated by bridges, gateways, 
backbone networks, and often multiple office floors or buildings. 

Network map components 
The Network Map file provided on your Inter.Poll Administration 
disk contains symbols that can help you construct a network map. 
These include icons that represent devices (such as Macintosh 
workstations and LaserWriters) and architectural components that 
you can incorporate into an office floor plan. 

The MacDraw program or a compatible graphics application is 
required to open and work with the network map components. 
However, if a graphics program is not available to you, the 
guidelines in this section are equally applicable to a map created by 
any other method, whether manual or computer-assisted. What's 
essential is to create a visual reference that you can correlate with 
Inter.Poll's device lists. 

~ ~ ~ LaserWriter AppleShare 

~ ~ 
User Name User Name 
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Creating the network map 
Follow the procedure below to produce the network map. If you 
don't have access to MacDraw or a compatible program, the 
principles of network mapping can be applied to whatever process 
you are using. 

Be sure to refer to the examples of typical network maps provided at 
the end of this chapter. 

Step 1: Acquire a floor plan 

It's often possible to avoid the time-consuming chore of measuring 
and drawing an original floor plan. The facilities management 
department of your company, or the building management office 
of your building, should have floor plans available of the type used 
for electrical and telephone wiring, emergency evacuation, or 
similar purposes. 

You will find a model floor plan to be helpful and time-saving in 
creating your map. 

Step 2: Reproduce the plan in MacDraw 

You'll want to recreate the floor plan with your Macintosh now, so 
that you can draw the network and nodes in position . 

• :. Note: If you simply draw your network manually onto a 
preexisting floor plan (to avoid the task of reproducing the plan 
in MacDraw), then each future change in the layout will require 
you to erase and redraw the affected network segments. Unless 
your network is very small and simple, this may be difficult and 
time-consuming. 

Creating the network map 29 



Open the Network Map file 

Open the Network Map me to access the predrawn network 
components. Before beginning your own map, use the Save As 
command from the File menu to rename the open copy of the 
Network Map me with your own map's name. In this way you can 
save your drawing, and you'll keep the network mapping tools for 
future use as well. 

Office parts 

The Network Map MacDraw file contains several types of standard 
floor plan components, such as office wall segments. These can be 
copied and reproportioned as needed for your plan. 

Work in full-size screen display mode, and reduce your drawing 
later if you need a very large area. Consult your MacDraw user's 
manual if you need help with this application. 

Step 3: Add the network cable and nodes 

The Network Map file contains symbols that represent the various 
types of nodes on AppleTalk networks. In addition, you may use 
MacDraw's drawing features to create your own symbols. 

Position node symbols 

Once your floor plan is completed, select the node symbols that are 
appropriate for your network. 

You can enlarge, reduce, and duplicate these symbols as many 
times as necessary to position them where the nodes are located in 
your floor plan. 

Label node names 

Each MacDraw node symbol has a node name label below it. Fill in 
the label with the name that is to be registered for this node on the 
AppleTalk network. (Remember that a single device can have more 
than one name if multiple network services are running on it.) 
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Draw the network cable 

The Network Map file doesn't provide any predrawn cable 
symbols, because these are best created with MacDraw's standard 
line drawing features . 

Select a line width that's bold enough to stand out in your floor 
plan-at least medium weight. MacDraw's segmented-line drawing 
feature , called the "polygon tool," will allow you to draw, change 
direction, and continue a single cable from node to node and from 
room to room. 

.:. Note: Use the Pen pull-down menu of line drawing patterns to 
select a different pattern for each network in an internet, or to set 
off a backbone from other cables. In this way your floor plan will 
show the different network segment locations at a glance. 

Step 4: Print the map 

Use a LaserWriter or ImageWriter to create printed copies of your 
network map. Take advantage of the legal-size paper capability of 
the printer, and the Landscape printing option for wide maps. 

If your network is large and complex, it may be impractical to 
reduce the drawing to print on a Single sheet of paper. Instead, it 
can be printed in separate segments and taped into a single map. 

Maintaining the network map 

Most computer networks are dynamic systems: they frequently 
change in size and configuration to respond to user needs. 

Whenever such changes occur, they must be recorded on the 
network map, to avoid errors in correlating Inter.Poll's device list 
output with the map. Always keep a current printed map for use in 
Inter.Poll troubleshooting. 

Examples of network maps 
Examples of the two most common types of network maps are 
shown on the following pages. Use them for reference, but feel free 
to construct your own map in whatever format is most suitable to 
your network situation. 
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Node and floor plan layout 
The most useful type of network map will show 

o the floor plan 

o the network cabling 

o the location of each network device 

Each workstation and network service on this map should be labeled 
with the device name. (For very large networks, this level of detail 
may be impractical; see the next section, "Skeleton Network 
Layout.") 

~/QQ//#/#//QQQQQ" ~ I~I - % W/&/##M I CI W#////fi w/////#///////. -

. , -= . 
Jones ~~ I LaserWriter I rl -~C=as=s""in--' 

.. " ..... ~ .~ 

~ I AppieShare I ~ 
,--T-----i 

~ 
Knapp 

~ 

Adams 

Penwarden AppieShare 
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Skeleton network layout 

Large network syst.ems with hundreds or thousands of nodes are 
better depicted with a more general map of network locations. This 
"skeleton" view of the internet layout allows visualization of the 
relative placement and interconnection of individual networks . 

• :. Note: The skeleton layout map should ideally be created in 
addition to the "node and floor plan" maps. These can be 
produced separately in single-network segments for reference to 
individual device locations. 
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This chapter consists of three sections: 

D "Basic Guidelines" describes techniques used at every level of 
Inter.Poll troubleshooting. These gUidelines deal with hardware, 
software, and cabling problems on LocalTalk networks, and can 
be applied to Etheffalk and other networks as well. 

D "Network Maintenance with Inter.Poll" provides an overview of 
preventive maintenance techniques, using progressive checks of 
network integrity to be performed on a regular basis. 

D "Network Troubleshooting with Inter.Poll" describes the 
conceptual strategy with which to approach network 
troubleshooting, through a series of symptom-and-procedure 
troubleshooting scenarios . 

• :. Note: Not all information in this chapter is applicable to all 
internet types or sizes. Administrators of smaller internets and 
single networks may wish to skip sections pertaining to zones and 
backbone networks, for example. Use the guidelines that pertain 
to the needs of your own network system. 

Basic guidelines 
Before proceeding to examples of network problems and strategies 
for dealing with them, here are some basic guidelines that apply to 
all network troubleshooting. 

Recognize network-based problems 
As noted at the beginning of this guide, an AppleTalk network is 
only a pipeline that serves to transport data among connected 
devices. The physical network components are simple, atld follow 
straightforward rules of operation. 

Yet it's often easy for users to blame any unspecified malfunction on 
"the network." When this happens, it's up to the network 
administrator to determine whether the fault is in fact network
related. To do this, start by analyzing the symptoms: 

• Are the symptoms related to a single workstation? 

If so, begin with the assumption that the problem is local, and 
try to solve it at this level before proceeding to network 
troubleshooting. 
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• Could the cause be user error? 

Did the user try to access a network service without first selecting 
it in the Chooser? Or select a print spooler in place of a printer? 
Retrace the steps that led to the problem and try again if 
appropriate. 

• Could the cause be non-network software or hardware? 

At times a system fault can occur while someone is trying to use 
the network, although the cause may not be network-related. Are 
the software and hardware involved at the problem location 
known to be problem-free? Follow the basic steps of local 
troubleshooting described in the next sections. 

First aid: Software 
A frequent source of trouble among networked devices is software 
incompatibility. The following are common varieties of this 
problem that can be checked at the local node level. 

System software version inconsistency 

Any node can cause network problems if it is operating with system 
software that differs from the network standard (for example, an 
outdated version of the System file). Symptoms might be limited to 
the offending node, or might affect network performance in other 
ways. 

Local device check: Software versions can often be checked at the 
affected workstations with the About [Program Name] command 
from the Apple eel) menu, or the Get Info command from the File 
menu. 

Remote device check: Inter.Poll can also check system software 
versions on individual remote nodes that are running the 
Responder software. To do this, use the System Info Packets feature 
of the Device Test window, described in Part II, "Inter. Poll 
Reference. " This test reports the currently running versions of the 
System, Finder, and LaserWriter software from any targeted device 
on the internet. 
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Remote network-wide check: A listing of system software versions 
can be displayed for a network-, zone-, or system-wide selection of 
Macintosh workstations, using the Get System Info command from 
the Special menu, described in Part II, "Inter. Poll Reference." 

Check with your authorized Apple dealer for the latest versions of 
system software for the devices on your network. 

Driver incompatibility 

Most network servers, including LaserWriters, file servers, and 
electronic mail applications, have associated controller programs 
called drivers that must be installed on every workstation using the 
service. When a network service fails to respond, the cause may be 
an incompatible software driver at the workstation requesting 
service. 

LaserWriters are particularly sensitive to the version numbers of 
Macintosh LaserWriter drivers. Use Inter.Poll to make sure that all 
workstations are running the same versions of these files. 

Usually, but not always (depending on the service type), an error 
message will be presented at the requesting workstation indicating 
an incompatible driver version. It will be necessary to remove this 
driver, install the appropriate version, and restart the system 
before service to this workstation can be resumed. This can be done 
by using the appropriate installation program (see the instructions 
provided with the corresponding software). 

Printing errors 

Errors can occur during the internal file formatting that precedes 
LaserWriter printing, resulting in the failure of the LaserWriter to 
respond. For example, the text formatting software may encounter 
a printing command that cannot be executed with the current font 
capabilities, causing a system error. This problem may not be 
described by anyon-screen error message, causing the 
transmission failure to appear network-related. 

When you suspect such an error in the formatting process, verify 
that the necessary printer software is present, and check response 
by printing a different file from the same workstation. Text 
formatting errors that disrupt printer service can often be cleared 
by resetting the printer. 
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First aid: Hardware 
This section describes the most common hardware-based causes of 
network failure. Consider these factors fIrst when users report 
problems . 

• :. Note: The hardware and cabling descriptions apply to LocalTalk 
networks, but Ethet'I'alk and other networks follow similar 
principles of operation. 

Breaks in network connections 

When a break occurs on the network, nodes on opposite sides of the 
break can no longer "see," or communicate with, anything on the 
network beyond the point of the break. 

In addition, network performance may become erratic even among 
nodes situated on the same side of the break, due to the possibility 
that a network cable is now improperly terminated (see the 
following section, "Cable Termination"). 

Here are three principal types of network breaks to look for: 

Break at connector box: If this occurs, the affected node 
becomes the network termination node for the side of the network 
that remains connected. Devices on this side may continue to 
operate properly, but will have no contact with devices beyond 
the termination point. 

The disconnected side is now improperly terminated, and is likely 
to experience performance problems in addition to the break in 
communication. 

Disconnected cable extenders: Cable extension connectors 
can become unplugged when moved around. If this happens, each 
side of the break will become an improperly terminated network, 
and will experience a::;sociated performance problems. 

Severed cable: Most network cable is sturdy, but breakage can 
still be caused by extreme stress, such as moving heavy furniture 
over cables. A severed cable will produce the s:J.me symptoms as 
unplugged cable connectors. 
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Intermittent connections 

When a network connection becomes loose or damaged without 
breaking completely, communication becomes intermittent 
between nodes on opposite sides of the problem site. 

Here are three principal causes of intermittent connections to look 
for: 

Loose connector contact: LocalTalk connector boxes are often 
moved, and attached nonlocking cable connectors can easily 
become loosened. These connectors should be checked and 
tightened whenever devices are moved. 

When properly installed, LocalTalk connectors lock into place. 
Older AppleTalk Personal Network connectors do not lock, and 
require third-party retention devices to help secure cable 
connections. 

Loose cable extenders: Nonlocking connector cables can 
become loose, although no break in contact may be visible. When 
checking for intermittent connections, completely unplug and 
reconnect the cables to make sure that firm contact exists. 

Damaged cable: A LocalTalk cable that has been damaged may 
still be capable of intermittent throughput, with occasional breaks 
in transmission. This may be the most difficult of network faults to 
detect if no external cable damage is visible. However, Inter.Poll 
may help to isolate the location of a throughput problem to a 
particular part of a network, and replacing the cable in this 
location can be one troubleshooting option . 

Cable termination 
LocalTalk and EtherTalk cabling systems use a bus topology, in 
which devices are strung out along a cable that terminates with a 
connector box (or terminator for EtherTalk) at each end. A 
properly terminated LocalTalk network has no dangling cable 
extending beyond the terminating connector box. 

- Improper 
----, .----.., r--::.--O termination 
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EtherTalk requires a separate terminator at each end of a network 
segment. EtherTalk is available on various cable media (including 
twisted-pair and fiber-optic cables) that have different termination 
requirements. The following represents a terminator for thin 
Ethernet cabling. Refer to the appropriate installation instructions 
for the termination requirements of your cable medium. 

- .--... t:!I-lt::::I~~ _Terminator ••• 

: EtherT alk Card : 

LocalTalk and EtherTalk do not support a continuous loop of cable, 
nor any T-shaped arrangement of devices. This means that each 
cable end of each network must be properly terminated with a node 
for the network to operate correctly. 
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Network maintenance with Inter.Poll 
The larger and more elaborate your internet, the more necessary it 
becomes to perform occasional checks of network integrity. These 
maintenance checks can be regularly scheduled, or simply worked 
into the ongoing routine of the network administrator. Either way, 
they should be frequent enough to keep network maintenance in a 
preventive mode, rather than a problem-driven, reactive mode. 

How frequent is "frequent enough"? In a medium-sized internet of 
two to five networks with a few dozen nodes, preventive 
maintenance checks might be performed once or twice weekly. In a 
larger internet spanning many zones, networks, and devices, a daily 
scheduled check of network integrity may be appropriate. A key 
determinant will be the stability of the network configuration-that 
is, how often devices are being moved, added, or deleted. 

By applying preventive maintenance practices to your network, 
problems in communication can often be detected and repaired 
before they interfere with user needs . 

• :. Note: To interpret Inter.Poll's diagnostic output, you'll need to 
consult a current reference source listing the zones, networks, 
and devices that should be connected to your internet. This 
reference can be a network map, as described in Chapter 3, or a 
combination of the network map and printed listings, described 
in "The File Menu" in Part II. 

To test network integrity, start Inter.Poll on the network admin
istrator's workstation and perform the checks described below. 

Step 1: Check zone listings 
The Select Zones listing in the Network Search window lists all zones 
that are visible to Inter.Poll. 

1 . Scroll through the zone listing to make sure that all are present, 
using either the network map or a printed zone list to check for 
names missing from the display. 

2. If one or more zone names are missing from the display, go to 
the "Missing Zone" scenario in the section of this chapter titled 
"Network Troubleshooting with Inter.Poll." 
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Step 2: Check networks 

Once zone integrity has been verified, proceed to checking 
networks. To do this, execute an Inter.Poli search of each zone in 
the internet, one zone at a time, and repeat the procedure for each. 
In a smaller internet it may be appropriate to check all zones in a 
single search. Note, however, that an all-zones search will be time
consuming and could gather more information than is practical to 
interpret at one time. Network checks may be better accomplished 
by testing zones individually. 

Perform a network search to display a device list that includes all 
networks visible to Inter-Poll. 

1 . Searching a single zone: Click the desired zone name in the 
Select Zones listing, and after performing the steps below, repeat 
the procedure for each zone name listed. 

Searching all zones: Shift-click through the entire Select Zones 
listing to highlight all displayed zone names. 

2. Set the sort order to Net to produce a device list in which devices 
are grouped by network. 

3 . With the All Named Devices option selected, click OK to begin 
the search and display the device list. 

4. Scroll through the device list, checking the Nets column to make 
sure that all networks are present. Refer to the network map or a 
printed device list to check for any network numbers missing 
from the display On a Single-network installation, the network 
number will be listed as zero). 

5. If one or more network numbers are missing from the display, go 
to the "Missing Network" scenario in the section of this chapter 
titled "Network Troubleshooting with Inter-Poll. " 
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Step 3: Check network paths 
Once the integrity of the internet has been verified, proceed to 
check the integrity of individual networks by testing paths to devices 
at the extremities of these networks. By targeting the endmost 
devices in this way, you can ascertain that the path through an 
individual network is free of breaks. 

While it may be too time-consuming to test all network paths on a 
large internet this way, it's good practice to make such checks part of 
the preventive maintenance routine, rotating the target networks 
each time the checks are performed. 

Use the network map to determine the node at the farthest extremity 
of a network to be tested. Then test the node's response to verify that 
the access path is clear. If the network is linked by a bridge 
connected at the network's center rather than at one end, then 
devices at both extremities should be tested to assure network 
integrity. 

1 . Display an Inter.Poll device list for the desired network and scan 
device names visually to identify incomplete networks. 

2. If one or more devices are missing from the list or not 
responding to the search, go to the "Missing Device" scenario in 
the "Network Troubleshooting with Inter.Poll" section of this 
chapter. 

Step 4: Test devices 
Finally, testing individual devices with loopback tests allows you to 
check for data loss and for the possibility of network path changes 
due to bridge malfunctions or traffic congestion. 

You must select a device to target for testing before the Device Test 
window may be displayed. The devices you select will be 
determined by the network regions you wish to test in your 
preventive maintenance routine. 
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• Checking for lost packets: The Device Test window contains a 
table of test statistics that displays the number of packets sent, 
received, and lost in any test. Consult this display when checking 
network integrity, as packet loss during a test can indicate trouble 
in the loop back path. 

In this event, perform loop back tests to individual devices along 
the path until you isolate the point where packet loss occurs. Then 
perform local troubleshooting at this location . 

• :. Note: Inter.Poll considers a packet lost if it has not completed 
a loop back test within the timeout period deSignated in the 
Device Test window (described in Part II). If this timeout 
period is set to the minimum (0.2 seconds), or is very low, 
then packet loss is to be expected. However, if a given test 
normally results in successfulloopback completion, an 
observation of packet loss indicates trouble. 

• Checking hop count: Hop counts to the targeted device are 
displayed during loop back testing. A regular part of preventive 
maintenance is maintaining awareness of hop counts to devices 
during loop back tests . 

For example, if a workstation on a network that is normally two 
hops away suddenly registers a hop count of four, this would 
indicate that a bridge malfunction or network break is forcing the 
packets onto an alternate route (this can only occur if your 
network layout permits more than one route to points on the 
internet). In this event, consult the network map to determine the 
normal route to this device, and perform loopback tests to 
individual devices along this route until you isolate the break 
point. 

.:. Note: If the network on which Inter.Poll is running contains 
more than one bridge, the hop count may vary by one from 
time to time, depending on the route most recently identified 
by AppleTalk routing protocols. This variability will not 
exceed one hop. 

See the discussion of hops under "Test Results" in the section 
titled "The Device Test Window" in Part II. 

The next section takes the principles of network maintenance a step 
further into the day-to-day process of troubleshooting-applying 
the principles in response to actual network problems. 
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Network troubleshooting with Inter.Poll 
This section is a reference source to help you troubleshoot networks 
and intemets. Keep in mind that since every AppleTalk network 
system is set up in a unique location with a unique layout of nodes, 
every network problem is also unique. A troubleshooting guide can 
provide strategies for solving these problems, but it cannot be a list 
of canned solutions. 

Basic troubleshooting 
Network problems share many common traits. Most involve a break 
in the network path occurring at a point of connection, or one of 
several common software problems. 

Likewise, troubleshooting remedies for dealing with these problems 
will also share many common traits. The most basic approach to all 
network troubleshooting can be reduced to the general steps below. 

1. Clearly def"tne the symptoms of the problem. 

2. Verify that these symptoms are in fact network-related. 

3. Determine which networks and devices are involved. 

4. Isolate the location of the problem through diagnostic 
tests. 

5. Visually check and correct any hardware problems at the 
location. 

6. Correct any software problems at the location. 
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Troubleshooting strategy 

So far this manual has shown you how Inter.Poll works, has outlined 
certain types of problems you may encounter with the network and 
why they occur, and has provided guidelines for preventive 
maintenance. Now, when trouble is at hand, how will these pieces fit 
together into a solution? 

• Look at the big picture: It's helpful to maintain a conception of 
the total network when addressing any malfunction. The network 
map is your most useful ally in visualizing the relationship 
between devices. 

• Use a logical top-down sequence: The troubleshooting 
process is a sequential series of tasks designed to isolate the 
location of a problem. It begins with an Inter.Poll device listing 
and, depending on the results of this search, proceeds to 
localized testing at the network or device level. 

Internet checks 

1 . Make sure affected devices are on the same or interconnected 
networks. 

2. If all devices on a network are missing from a device list, the 
problem is most likely to be bridge-related. 

3. Make sure that bridges have been properly configured. Check 
operation and installation manuals for bridge hardware and 
software. 

4 . If the network medium is Ethernet, check the EtherTalk hardware 
and software installation, and refer to the appropriate 
documentation. 

Workgroup checks 

1 . Check for disconnected cables. 

2. Check and tighten all network connections, including connector 
boxes and cable extenders. 

3. If the medium is LocalTalk, or thick or thin Ethernet cable, check 
that the network is installed with devices in a line, not a closed 
loop Cother Ethernet media may have different layout 
conventions). 

4. Check for proper network termination, as described in the 
section "Cable Termination" earlier in this chapter. 
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Localized device checks 

1 . Is the affected device turned on? 

2. Is the affected device attached to the network? 

3 . If the medium is LocalTalk, is the LocalTalk connector attached 
to the printer port? 

4. Check for appropriate versions of system software. 

5 . Check for correct LaserWriter driver software. 

6. If the device is a Macintosh, make sure AppleTalk is set to Active 
in the Chooser. 

7 . If the device is a Macintosh on EtherTalk, then make sure the 
EtherTalk option is selected in the Control Panel's Network 
options (refer to the EtherTalk User's Guide for details). 

The sections that follow take you through a sequence of 
troubleshooting steps in scenarios of the most common network 
malfunctions: 

o missing zone 

o missing network 

o missing device 

o intermittent loss of service 

o isolating internet breaks 

Missing zone 

Symptoms 

One or more zones are missing from a user's Macintosh Chooser 
window or the Network Search window's zone display (this only 
applies to networks containing more than one zone). 

Procedure 

1 . Consult the network map to determine the location of the missing 
zone(s) relative to the Inter.Poll workstation. 

2. Select the zone that is adjacent to the missing zone and nearest to 
the Inter.Poll workstation, and perform an All Named Devices 
listing to reveal the possible break point. Verify that all networks 
are present in this adjacent zone. 
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3. Determine from the network map which device is the last 
responding node on the path to the missing zone. 

4. Go to the location of this last device and follow local 
troubleshooting guidelines: 

D Check connectors and cable termination. 

o Check the bridge connecting the missing zone to the "visible" 
part of the internet. Refer to the owner's manual for this 
device. 

5. Repair or replace any malfunctioning device or cables and retry 
listing the zone. 

6. If you find no visible break and local checks of hardware and 
cabling fail to solve the problem, install Inter.Poll on a 
Macintosh connected inside the nonresponding zone 
(preferably the Macintosh farthest from the zone's connecting 
bridge). 

D Perform an All Named Devices listing. 

D Compare the device list with the network map. 

D If any device within the zone is missing from the list, follow 
local troubleshooting guidelines at that location. 

7 . If no trouble source is located in step 6, perform loopback tests 
from the Inter.Poll workstation inside the zone. 

D First check the bridge connecting the zone to the internet. 

D If you receive no response, test each contiguous device 
starting from the bridge until the break is isolated. 

See the instructions in Part II, "The Device Test Window." 
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Missing network 

Symptoms 

One or more networks are missing from the Inter.Poll device list. 

Procedure 

1 . Consult the network map to determine the location of the missing 
network relative to the Inter.Poll workstation. 

2. Perform an All Named Devices listing of the zone containing the 
missing network, and then determine from the network map 
which device is the last responding node on the path to the 
missing network. 

3. Go to the location of this last device and follow local 
troubleshooting guidelines: 

o Check connectors and cable termination. 

o Check the bridge connecting the missing network to the 
"visible" part of the internet. Refer to the owner's manual for 
this device. 

4. Repair or replace any malfunctioning device or cables and retry 
listing the network. 

5. If you find no visible break and local checks of hardware and 
cabling fail to solve the problem, install Inter.Poll on a 
Macintosh connected inside the nonresponding network 
(preferably the Macintosh farthest from the network's connecting 
bridge). 

o Perform an All Named Devices listing of the local zone (select 
sorting by Net to make the device list easier to read). 

o Compare the device list with the network map. 

o If any device within the network is missing from the list, follow 
local troubleshooting guidelines at that location. 

6. If no trouble source is located in step 5, perform loopback tests 
from the Inter.Poll workstation inside the network. 

o First check the bridge connecting the network to the internet. 

o If you receive no response, test each contiguous device 
starting from the bridge until the break is isolated. 

See the instructions in Part II, "The Device Test Window." 
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Missing device 

Symptoms 

One or more devices are missing from the Inter.Poll device list. 

Procedure 

1 . Consult the network map to determine the location of the missing 
device(s) relative to the Inter.Poll workstation. 

2. Go to the location of the missing device(s) and follow local 
troubleshooting guidelines: 

o Check connectors and cables. 

o If the device is a Macintosh, make sure the LocalTalk 
connector is attached to the printer port. 

o If the device is a Macintosh, make sure it's running the correct 
version of the Responder software, and that this program is 
located in the System Folder. 

o If the device is a Macintosh, make sure AppleTalk is set to 
Active in the Chooser window. 

3. Repair or replace any malfunctioning connectors, cables, or 
software, and retry listing the device. 

4 . If you receive no response, and if you can't see any network 
services from the affected workstation's Chooser, the problem 
may be caused by the device's internal network connection 
hardware. Try substituting a known working device, and consult 
your hardware service representative about the malfunctioning 
unit. 
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IntermiHent loss of a network service 

Symptoms 

One or more workstations are receiving erratic, slow, or 
occasionally interrupted service from a LaserWriter or file server. 

Procedure 

1 . Display an Inter.Poll device list to verify that the affected devices 
are registering properly. 

o If a device is missing from the list, follow the procedure under 
"Missing Device. " 

o If all devices are listed, the symptoms may be the result of an 
intermittent connection. Follow the procedure below to 
isolate the location and troubleshoot. 

2. Consult the network map to determine the location of the 
affected workstation relative to the offending printer or server. 

3. Take a copy of Inter.Poll to the affected workstation, and from 
there begin testing devices in the path to the printer or server. 
Perform a loop back test on the nearest device first, and test 
successive devices until results indicate a loss of test packets. This 
will isolate the network segment where the intermittent break is 
originating. 

4. Perform local troubleshooting at the location of the intermittent 
break. Refer to the section of this chapter called "First Aid: 
Hardware" for more information on intermittent connections. 
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Internet break example 
Consider the following example of a break on a multizone internet. 
In fully functional condition, the Inter.Poll device listing for this 
internet would show the following zones and networks: 

.:. Note: The network administrator's workstation is located on 
Network 4. 

Zone 

A 

B 

C 

Network 

4 

1,2 

3 

For illustration purposes, a break in this example results in a device 
list showing the following zones and networks: 

Zone 

A 

B 

Network 

4 

1 

To interpret such information, it's necessary to check the network 
map for the internet layout. The network map shows the following: 
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The probable location of the break is now evident. For the 
administrator's workstation to list networks 4 and 1, yet not 2 or 3, 
a break must have occurred somewhere at the link between networks 
1 and 2. 

There are several connection points along this link, and all should 
be checked. Particularly, Bridge Y is at this location, and is a likely 
cause of the problem. This device should be checked for loose 
connections, tested, and replaced if necessary. 
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This Inter.Poll reference section describes each screen option and 
menu command that you will encounter in the course of operating 
Inter.Poll. 

The section is divided into the seven principal program 
components of Inter.Poll: 

o the Network Search window 

o the Device list window 

o the Options menu 

o the Device Test window 

o the File menu 

o the Special menu 

o the Edit menu 

Starting and quiHing 
To start Inter.Poll, simply double-click its application icon on your 
Macintosh screen. 

To exit from Inter.Poll, choose Quit from the File menu. 

The Network Search window 
The Network Search window is displayed each time you start 
Inter.Poll, and it may also be invoked from the Options menu at 
any time during program operation. 

The Network Search window allows you to specify search criteria 
including selected zones, search duration, sorting order, and 
parameters of devices to be searched. 

The options available in this window are described below. 

.. Note: The default setting for each option is indicated, but these 
can be superseded by user-defined default settings with the Save 
Preferences option (see the File menu description later in this 
section). 
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r··· Se 1 ect Zone(s)············· 

Pub lications 

Total Zones: 3 ...................................... 

,····Search Ti me:··················· 

~Min ~sec 
D Continuous 

....... . ........................................ ; 

Select Zone 

The zone listing in the upper-left corner of the window displays all 
zones currently visible to the Inter.Poll workstation. The device 
search will cover any zone(s) highlighted on this list. The default 
zone is always the zone in which the Inter.Poll program is running. 

If your network is a single (nonbridged) network with no defined 
zones, this box will display "No Zones." 

Select one zone by positioning the pointer over the desired zone 
name and clicking the mouse button once. 

Select one or more additional zones by Shift-clicking any additional 
zone name(s). 

Select all zones in the network by shift-clicking through the list until 
all zones are highlighted. 

Search Time 

The duration of the device search may be specified in minutes 
and seconds. 

To enter the desired search time, select the currently displayed time 
and type the new value over it, or position the pointer to the right of 
the displayed value, backspace, and type the new value. 

.:. Warning: The Continuous time option extends network scanning 
indefinitely, until you stop the search manually. Do not select 
this option under normal circumstances, as searching can create 
considerable network traffic. (Continuous searching may be a 
useful option for extended testing during nonbusiness hours.) 

Search duration should be set to the time that your experience has 
shown is needed to complete the particular type of search. This 
time will vary depending on network size and the number of zones 
selected, as well as the search characteristics defined with the 
Settings feature (see "The Special Menu," later in this section). The 
default search time of two minutes and thirty seconds should be 
sufficient for a large internet. 
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; .... ·Se1 ect Sort i ng: .. · .... · ........ ~ 

, I Net I i 
@ Ascending 

o Descending 

@ All Named Deuices 

@ Deuices Matching: 

Add 

Select Sorting 

Device lists can be sorted by Network, Node, Socket, Name, Type, 
or Zone. The order in which the device list will be sorted can be 
specified as Ascending or Descending by clicking one of the two 
radio buttons in this box. A sort order selection will be valid only 
if the corresponding column is displayed in the device list (see 
the Device List Columns command, described in the section "The 
Options Menu"). 

To select the search field on which to sort, place the pointer over 
the currently displayed field in the box, and press the mouse button 
to display a pop-up menu containing the sorting choices. Then 
drag the pointer to the desired selection and release the mouse 
button. 

The default sort is by Network, in Ascending order. 

Search for All Named Devices 

When the All Named Devices option is selected, the device search 
will be executed with no further search criteria entered, and the 
resulting list will show all responding devices in the specified 
zones. 

Click the All Named Devices button at the left side of the window (if 
not already selected) to confirm that the search will have no device 
match parameters. 

The default setting for this option is All Named Devices. 

Search for Devices Matching 

Click the Devices Matching button to add specific search criteria 
for the devices you wish to list. The following sections describe 
the search criteria available. 

The Add button 

Since multiple search criteria may be entered for a single search, 
each must be added individually to the list of search parameters. 

Click the Add button after each match selection to register the 
selection in the Search Criteria box at the bottom of the window. 

58 Part II: Inter.Poll Reference 



Clear 

Clear All 

The Clear button 

The Clear button allows you to delete individual search criteria 
from the Search Criteria box, while retaining the balance of the 
parameters unchanged. If you have made more than one selection 
in a given field, the Clear button will clear all selections in that 
field. 

To clear, use the mouse to select the parameter you wish to delete, 
and then click the Clear button. 

The Clear All button 

When clicked, the Clear All button deletes all selected parameters 
from the Search Criteria box. 

Select match parameter(s) 

Match .. I N_e_t ____ .. 1 The Match option allows you to specify parameters to limit the 
devices that Inter. Poll will list (for example, devices whose type is 
Macintosh Plus only). 

Drag through the pop-up menu to the right of the word Match, until 
the pointer is over the desired parameter. The options are: 

Net: List only devices attached to a specific network number. 

Name: Search for a specific device by name. 

Type: List only devices matching a specific type. 

Unnamed: Include unnamed devices (devices not responding with 
name identification). 

Important Selecting the unnamed devices parameter produces a device 
list that contains all active devices Inter. Poll encounters. 
Including those incapable of responding with an AppleTalk 
name. 

Note. however, that a network will not appear on a device list 
if It contains only unnamed devices. This Is because Inter. Poll 
can only acquire network numbers-needed to recognize a 
network-from the responses of named devices running on the 
given network. 

This limitation can be bypassed if you already know the 
network number and simply perform a "Devices Matching" 
search. with the network number manually entered In the 
Search Criteria field. 
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Wi thl L-_____ ..Jtf1=.� 

~ .... , 

AFPSeruer 
Apple IIGS 
laserWriter 
Macintosh II 
Macintosh Plus 
Macintosh SE 

@ EHact Match 

@ Partial Match 

··Search Criteria: 
Net: 2216 
Name: LONG HAUL 
Type : LASER'w'RITER 

in Zone: Publications 

Enter match qualifier(s) 

Enter the qualifier that corresponds to the selected parameter in 
the box labeled "With" following the Match pop-up menu. For 
example, if you wish to list LaserWriters and have selected the 
parameter "Type," you would enter the qualifier "LaserWriter" in 
this box, or select the type using the reference pop-up menu 
described in the following paragraph. 

Reference pop-up menu: To the right of the qualifier box is an 
icon for a reference pop-up menu. Click this icon to display a list 
of all available choices for the current parameter. Again, if the 
parameter were Type, this list might include LaserWriter, 
AppleShare Server, and Macintosh Plus. If the parameter were Net, 
the list would display all known network numbers. The items 
displayed in this list represent the actual ones currently on your 
network system. 

When you choose an item from the pop-up menu, it is 
automatically entered into the match qualifier box (Inter. Poll is 
actually performing a network search to find the devices listed in 
this pop-up menu; it may take a few moments before the device you 
seek appears on the list). 

Exact or Partial Match: Click the Exact Match button to list only 
devices that match the given parameter and qualifier exactly. 

Click the Partial Match button to list all devices whose name (or num
ber, depending on what you are matching) contains the character 
string entered for the given parameter and qualifier (for example, 
"Mac" would match Macintosh Plus, Macintosh II, and so on). 

Partial matching is the default setting for this option. 

.:. Note: Be sure to click the Add button following the definition of 
each device match parameter. 

Additional parameters 

After you click the Add button, the parameter and qualifier will 
appear in the Search Criteria box at the bottom of the window. 

To select additional parameters-for example, to specify the 
network number and device type matches to list-simply repeat the 
procedure used for the initial parameter, and click the Add button 
once more. 

Inter.Poll will allow you to add up to four search criteria for each 
selected parameter. 
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Start 

Start search 
When you have selected all search criteria and entered matching 
parameters, you may begin the network search. 

Click Start or press Return to initiate the search and display the 
Device List window. 

The Device List window 
Once the network search is initiated, Inter.Poll displays the Device 
List window. The search status is displayed in the upper-left portion 
of the window, and elapsed search time is tracked by the timer bar at 
the upper right. 

Status: 

Searching for A 11 Devices 

ZonE' : Product Management 
T ota 1 Enkies : 7 

IIIIIIiIllet aNode IName 

27310 39 Darryl 
27310 51 ,John 
27310 82 Betty 
273 10 11 3 James 
27310 117 Feli x 
27310 121 Fred 
27310 131 Server A 

Oeuice List 

Clear ] n Start J) 
Search Time : 2 Min 30 Sec 

Search TimE' (%) 
W$§$ffff,aw#&ff~#/J 
I I I 
a 50 100 

I Type 

Macintosh Plus 
MS-DOS 3 . 2 
Mac intosh Plus 
Mac intosh I I 
App I e I lOS 
Mac intosh SE 
AFPServer 

Zone 

Produc t Managemen t 
Produc t Managemen t 
Produc t Manogemen t 
Produc t Managemen t 
Produc t Managemen t 
Produc t Managemen t 
Produc t Managemen t 

The Device List window displays the results of the network search in 
columns that can be formatted interactively, as described in the 
following sections. 
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.------- ') 
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Move a column 
Position the pointer inside any column heading label; the pointer 
changes to a two-headed arrow. Now you can drag the label from its 
current position to the desired new position. 

The page will automatically reformat to display the column contents 
under the new heading label position. 

Delete a column 

Position the pointer inside any column heading label and drag the 
label from its current position toward the top of the screen, or until 
the gray dotted outline of the label disappears. 

The contents of the entire column will disappear from the page (you 
can always recover a deleted column by using the Device List 
Columns command from the Options menu). 

Change column width 
Position the pointer on the left or right edge of any column 
heading label; it will turn into a bidirectional pointer. Now you 
can drag the edge horizontally across the heading bar. The 
column edge will follow the pointer until released, and the entire 
column will be widened accordingly. Use the same technique to 
reduce column width. 

Stop and restart search 
While the network search is executing, you can stop it at any time by 
clicking the Stop button in the upper-right corner of the screen. 
This causes the button to toggle to a Start button, which may then be 
clicked at any time to resume the search with the same parameters as 
were previously in effect. 
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The Options menu 
Most Inter.Poll program options are directly accessible in the 
program's various windows. In addition, the following commands 
are presented in the Options menu: 

o Network Search 

o Device List Columns 

o List Aliases 

o List Using Hexadecimal Numbers 

o Find Entry 

o Find Same 

These commands are described in the following sections. 

Network Search ... 
This command invokes the Network Search window, described in 
the previous section. 

The Network Search window allows you to enter search criteria for 
device lookups on the network, and is displayed automatically at 
program startup. Use this command to return to the Network Search 
window at any time to redefine your search. 

When you select this command while already displaying the 
Network Search window, Inter.Poll refreshes the current zone 
listings in the window's Select Zone box. 

Device List Columns ... 
When you choose this command, the following box is displayed: 

Oeuice list Columns (( OK l) 

Display: 
[ Cancel 1 

IZJ Net Number IZJ Name 

IZJ Node Number IZJ Type 

o Socket Number IZJ Zone 
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Use this box to designate which data fields will be displayed in 
columns in the Device List window. 

To add a column, position the pointer in the check box next to the 
desired field name and click. An "X" will appear in the box. 

To delete a selected column (already marked with an "X"), click in 
the check box next to that field name. 

When your column selections are complete, click OK or press 
Return to confirm the settings and return to the previous window . 

• :. Note: Device List columns can also be deleted, moved, and 
formatted directly from the Device List window. See the earlier 
section, "The Device List Window." 

List Aliases 
Aliases are device names created when two or more network 
functions located in the same device are recognized by Inter.Poll as 
individual devices. This could take place if, for example, a 
Macintosh were being used concurrently as a file selVer and a print 
spooler. Each of these is considered a "device" by Inter.Poll. 

As a result, the device list would contain two entries having different 
device names and types, but the same network and node numbers. 

The default setting of List Aliases is On. Click this option to toggle 
off the alias listing feature when deSired, and click it again to turn it 
back on. 

List Using Hexadecimal Numbers 
When selected, this option changes the display of network, node, 
and socket numbers from decimal to hexadecimal (base 16), and 
back to decimal when deselected. 

This is of value when you want to correlate Inter.Poll network listings 
with other sources that may list device identifiers in hexadecimal 
notation; for example, certain bridge configuration programs. 
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Find Entry ... 
The Find Entry command allows you to locate an entry quickly on a 
device list by typing the information that you want to look for. 

When you choose the Find Entry command, the following dialog 
box is displayed: 

Find what? 

@Net Number 
o Node Number 
o SO( ki~ t Nmnt!(Jr 

OName 
OType 
OZone 

( Cancel 1 

n Find II 

Click the radio button for the device list column that corresponds to 
the information you want to type. Then type the entry identification 
in the box, and click OK or press Return to search for the entry. 
(Inter. Poll will search for a partial match if no exact match is 
found.) The device list will be redisplayed with the desired entry 
highlighted-if necessary, advanced or backed up to the 
appropriate section of the list. This feature is useful for finding 
entries on long device lists. 

As an alternate way to access this command, you may double-click 
on any of the column headings to display the Find Entry dialog box 
with the particular column title selected. 

Find Same 
The Find Same command allows you to instantly redisplay the most 
recent device list entry located by the Find Entry command. To do 
this, choose Find Same from the Options menu, and the device list 
will be redisplayed with the desired entry highlighted-if necessary, 
advanced or backed up to the appropriate section of the list. 
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The Device Test window 
The Device Test window, from which loopback tests are initiated, 
can be invoked either from the Device Test command in the Special 
menu, or by double-clicking any device listed in the Device List 
window. In either case, program interaction is identical. The 
following window is displayed: 

Devi ce: 
Not: 27445 Nodo : 8 
Alan - Macintosh II - nets-r-us 

(( )) Using: 
Start 

Packets : It"l I o Echo Pkts ( Done 1 
Interval: 12.5 I Sees o Printer Status Packets 

Timeout: 11.5 I SE'CS 
@ System Info Packets 

Rcv,j : 1 lost : 0 
Packets Sent: Loft : 0 Total : 1 

Current Average Minimum Maximum 

Hops Away I 2 2 .00 2 · 2 

I ( Clear J Dolay (socs) 0 .05 0 .05 0 .05 0 .05 

Status: 
Macintosh S\JstE"m Fi le V(>rsion 4 .2©Apple Computer , Inc . 1983-87 .0.11 .. 
Macintosh FindE'r Version 6 .0 
LaserWriter : Veorsion 5 .0 I October 1987 
Inter. Poll INIT Vers ion : 10.0. 1 
AppleTalk Driver Version : 49 

Loopback tests return information on link integrity and response 
time between the Inter.Poll workstation and the targeted device. By 
sending packet tests to a sequence of devices along a network, it's 
possible to determine at which point in the network a transmission 
problem is originating. 

The following are valid setting ranges for loopback tests: 

• Packets: 1-32,767 

• Interval: 0-99,999.99 seconds 

• Timeout: 0.2- 99,999.99 seconds 

The intelVal time is the delay between packets sent. An intelVal time 
of zero will cause the system to send packets as quickly as it is 
capable (this may be useful in network tests requiring a very high 
traffic load). The timeout value is the length of time that Inter.Poll 
will wait for a loopback response before declaring a packet lost. 
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Packet types and functions 

The packet types described below can be selected in the Device Test 
window. Click the radio button next to your desired selection to 
activate that packet type. 

Echo packets 

This packet type tests link integrity between the Inter.Poll 
workstation and any other workstation, as well as many server types. 
The information returned includes the distance in hops, time delay 
in seconds, and number of packets sent, received, and lost. 

Short or long packets: When you select echo packets, options are 
displayed for short or long packet types. The default type, short 
packets, would normally be used to check node connectivity. Long 
packets would be useful, for example, to check packet loss due to 
network congestion by artificially loading network traffic. 

Printer status packets 

This packet type tests LaserWriters and other devices that 
communicate using the Printer Access Protocol (see Appendix A 
for AppleTalk protocol information). In addition to distance, time, 
and number of packets, printer status packet tests return the printer 
status messages normally associated with LaserWriters (for 
example, those indicating a job in progress, the originating user 
name, and so on). 

System information packets 

System information packet tests query Macintosh nodes running 
Responder for current system software versions. Version numbers 
are returned for the System, Finder, Responder, AppleTalk driver, 
and LaserWriter driver of the targeted node. 
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Test results 

Received 

This value shows the number of sent packets that have been returned 
to the Inter.Poll workstation by the target device, within the timeout 
period specified in the Device Test window. 

Lost 

This value shows the number of sent packets that have not been 
returned to the Inter.Poll workstation by the target device. Lost 
packets are those not returned within the specified timeout period. 

Left 

This value counts down the number of packets remaining to be sent 
to the target device. 

Total 

This value shows the total number of packets that have been sent to 
the target device. 

Hops away 

This statistic reports the path, in number of bridge crossings, from 
the Inter.Poll workstation to the tested device . 

.:. Note: The number of hops to a given device depends on the 
route taken, which in tum depends on the network address tables 
furnished to bridges by AppleTalk's Routing Table Maintenance 
Protocol. If the network you are connected to contains more than 
one bridge, the hop count may vary by one from time to time, 
depending on the route most recently identified by the routing 
protocol. This variability will not exceed one hop. 

Delay 

This value shows the round trip loopback time, in seconds, that was 
taken by each packet to complete the test to the target device. 
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Test commands 

Start/Stop 

Once the packet type has been selected, click the Start button or 
press Return to begin testing. The button then toggles to Stop. The 
Stop button can be clicked at any time to interrupt testing. 

Clear 

Click the Clear command to reset test results to zero. If this is not 
done, cumulative totals will be tallied as long as tests of the current 
device are repeated. 

Done 
Click the Done button to exit from the Device Test window and to 
return to the Device List window. 

The File menu 
Commands from the File menu allow you to save or print Inter.Poll 
device lists, and to save Inter.Poll program parameter settings. 

Save Preferences ... 

This command displays the Save Preferences dialog box. Program 
settings selected in this box will be stored and reused each time 
Inter.Poll is started. The Inter.Poll Preferences file is stored in the 
System Folder. One such file is stored automatically by Inter.Poll, 
regardless of whether the Save Preferences command is used. 
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The following settings may be stored: 

• Column positions: the order and width formats of the 
displayed columns in the Device List window 

• Menu options: the program parameters selected via pull-down 
menu commands, including parameters changed in the Internal 
Settings dialog box and the Device Test window 

• Sorting options: the device list sort parameters 

• Page Setup settings: the page parameters selected for printing 
device lists 

SlIve Preferences 

007 Device List : 

C8:I SlIve Column Positions 

Options Menu : 

C8:I SlIve Menu Selections 

Searching and Sorting : 

C8:I SlIve Criterill 

Printing : 

C8:I SlIve Pllge Setup Settings 

I( SlIve ]1 

[ Cllncel ] 

Click the check box next to each setting you wish to save. An "X" will 
appear in the box to confirm the selection. To cancel saving a 
setting, click in its box again to remove the "X". 

Save List... 
This command allows you to save a file copy of the currently 
displayed device list. 

Choose the Save List command to invoke the standard Save As 
dialog box, shown on the facing page. One of the three following 
save options may be selected: 

o Devices 

o Zones 

o System Information 
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I ~ System Tools I 
:-.~ 2nll bit! pietun) 
C I III t'r -Pnll it: nn~, 
D TH~, l Ilin\!r1lm 
D Iton~) 

Save Device list as: 

Save lists: 

~ ~ System Tools 

Eject 

Drive 1 

Save ~ 

Cancel 1 

@Devices 0 ZnnH~, 0 >qslern Infomldlion 

Click the radio button next to the device list parameter you wish to 
save (only one parameter may be selected). Select the folder in 
which you want to store the device list from the displayed listing. 
Then click Save. You may only select a list type for which a list has 
been produced in the current Inter.Poll session. 

The list is saved as a tab-delimited text document, which can later 
be displayed or printed using any application capable of opening a 
Macintosh text file (for example, MacWrite or Microsoft Excel). 

Page Setup ... 

Use the Page Setup command to prepare for printing a device list. 
This command invokes the standard Page Setup dialog box, with all 
options associated with the currently selected printer. 

,;;La;;;,s;,;;e,,;,rW;;:;,;;,;ri,,;,te;;;r;,;;p;,;;a;gg,;;e;,;;S;;;,et;,;;u;,;;p==========v~4;;;;.o~ t OK lJ 
Paper: @ US Letter 0 R4 Letter Reduce or 1rr.ti'I OJo o US Legal 0 B5 Letter Enlarge: IAlIW [ Cancel) 

Orientation Printer Effects : 

IZI Font Substitution? 
IZI Smoothing? 
IZI Faster Bitmap Printing? 

[Options 1 
Help 

.:. Note: Be sure to select the horizontal page orientation if there are 
several wide columns in the device list to be printed. 
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Print Lists ... 
This command displays the standard Print dialog box, with options 
for selecting one or more of the following items to be included on 
the list: 

o Devices 

o Zones 

o System Information 

LaserllJriter <Paradise Lost) v4 .0 n OK D 
cOPies:I .. 1 Pages: @ All 0 From: 0 To: 0 [Cancel 1 
COlier Page: @ No 0 First Page 0 Last Page [ Help 1 
Paper Source: @ Paper Cassette 0 Manual Feed 

Print Lists: ~ Dellices ~ Zones o Sl.ls1ern lnfolHw1iorl 

Click the check box preceding the desired selection(s), make any 
desired changes to the default printing parameters, and click OK to 
send the device list to the printer. Print options will be dimmed if 
the corresponding information is not in the current list. 

Quit 
Choose Quit from the File menu to exit from Inter.Poll and return to 
the Macintosh Finder. 

The Special menu 
The Special menu contains commands associated with te:Sting and 
reporting on network devices. 

Device Test... 
This command invokes the Device Test window, described earlier. 
The Device Test command in the Special menu provides another 
way to access this window. 
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To display the window, select any device on the displayed list, and 
then choose the Device Test command to test this node with 
loop back tests. (This supplements the access method of double
clicking any device on the list to access the test window.) 

Settings ... 
This command displays the Internal Settings dialog box, which 
contains settings for the frequency, duration, and type of device 
lookups performed in a network search . 

• :. Note: The Settings command is an advanced feature of 
Inter.Poll, intended for fine-tuning search performance. For 
further explanation of how AppleTalk protocols support this 
feature, refer to the discussion of Name Binding Protocol (NBP) 
lookups in Inside AppleTalk. 

Internal Settings 

Syne Interual: ~ 
Syne Count: ~ 

Rsyne Interual: ~ 
Rsyne Count: ~ 

t OK )1 

[ Caneel ) 

I:8l Lookup Interual: 1 0 .0 Isees 

o Confirm Interual: 12.5 Isees 

o [eho Interual: 11.0 Isees 

o Unnamed I nterual: 11.0 Isees 

Lookup interval and count 

The top four settings in this window determine the number of 
lookups and the duration of the delay interval between lookups. The 
network search consists of a synchronous lookup sequence, in which 
all selected zones are polled without interruption, followed by an 
asynchronous lookup sequence performed in background mode 
(that is, subject to priority interrupts). 

The Inter.Polllookup is broadcast to each network, not directed to 
individual devices. Lookup duration is measured in the standard 
Macintosh time unit of "ticks," signifying 1I60th second. 
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The settings are: 

D Sync Interval 

D Sync Count 

D Async Interval 

D Async Count 

.:. Note: The valid range for interval and count settings is 1-16. 

Each has a default value, as shown in the screen diagram. Change 
these settings to improve search accuracy if, for example, network 
interference noise is causing lookup packets to be lost. If such 
interference exists, it may be useful to increase both sync and async 
intervals and counts. A recommended guideline is to try doubling 
the default values of these settings. 

Warning Increasing the lookup count and/or Interval will also Increase 
the time required to complete a network search. 

Lookup type selection 

At least one lookup interval must be selected from this list for 
Inter.Poll to be operational. 

D Click the check box to the left of the selection to activate the 
lookup type. 

D If desired, change the interval time for any lookup type that has 
been activated. 

D The valid range in seconds for these intervals is 0.1-99,999.99. 

One or more of the follOWing lookups may be selected: 

Lookup Interval: This option determines the wait time between 
asynchronous lookups. 

Confirm Interval: This option implements a device confirmation 
check, which verifies that each device on a list is still responding. 
This eliminates device listing duplications caused when devices are 
reinitialized and change their names. The Confirm Interval is set 
automatically when Continuous Search is selected in the Network 
Search window, and can also be set manually by making this 
selection. 
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Echo Interval: This option broadcasts an echo packet to all zones 
selected in the current search. Any device running Responder or 
AppleTalk driver version 4.1 and above will respond. This differs 
from the lookup broadcast in that it is directed to known networks on 
the current device list. Responses include the device node number 
and network number only. 

Unnamed Interval: This option allows the detection of devices that 
have neither the Responder software nor Echo Protocol capability. 
The unnamed devices can only be detected on the network on which 
Inter.Poll is running; this lookup will not operate across an internet 
bridge. 

Get System Info ... 

The Get System Info command in the Special menu displays 
Inter.Poll's System Information window. From this window you may 
list currently running software versions of the System, Finder, and 
LaserWriter driver files for each active Macintosh on the network. 

o System Information 

Di splay: @ System File Uersion 

o Finder File Uersion 
[ Get System Info] 

o LaserWriter Driuer Uersion 

Name- Typo 

Betty Mac intosh I I 
Dav i d 8mt th Mac j n tosh SE 
Gary Chang Mac intosh SE 
Tim Knight Moc i nt.osh SE 
Mark Macintosh SE 
Andrew Jay Mac intosh Plus 
Chr i stine Macintosh SE 
Bi II Wi lkins Mac intosh SE 
Karen Jones Mac intosh II 
Tom Walker Mac intosh I I 
Nick Arthur Mac intosh II 
James Wa tson Mac in tosh II 

List System file versions 

Sy stem file V£'rslon 
Mac intosh Sys tern F i I e Uers i on 4.2 
Macintosh System Fi Ie Version 4 . 2 
Macintosh Sys tem Fi Ie Version 4 . 2 
Macintosh System F i Ie Version 4 . 2 
Mac: i ntos h System F i Ie Uers i on 4 . 2 
Mac in tosh Sys tern F i Ie Uers i on 4 .2 
Macintosh System F i Ie Uersion 4 . 2 
Mac intosh System F i Ie Uers ion 4 .2 
Macintosh System Fi I e Uersion 4 .2 
Mac intosh Sy stem Fi Ie Uers i on 4 . 2 
Mac in tosh Sys tem Fi Ie Uers i on 4.2 
Mac intosh S stem F i Ie Uers i on 4 . 2 

Click this button to display a list of all active Macintosh nodes and 
their current System file version numbers. 

List Finder file versions 

Click this button to display a list of all active Macintosh nodes and 
their current Finder file version numbers. 
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List LaserWriter driver versions 

Click this button to display a list of all active Macintosh nodes and 
their current LaserWriter driver version numbers. 

Get system information 

After selecting which software type to list, click the Get System Info 
button, or simply press Return, to begin scanning the active device 
list. Inter.Poll scans the devices and returns the information 
requested. Once the entire list has been scanned, the Get System 
Info button will flash and the scan will stop. To repeat the scan, click 
this button again. 

Inter.PolI Workstation 
The Inter.Poll Workstation Window displays identifying data about 
the workstation on which Inter.Poll is currently running. The 
following information is provided: 

o zone name 

o network number 

o node number 

o device name 

o device type 

D Inter. Poll Workstation 

Our Zone : Market i ng 

Our Nel : 27412 Name : Bob 

Our Node :38 Type : Macintosh P lus 
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The Edit menu 
The standard Macintosh editing functions are supported in the 
Inter-Poll Edit menu. However, Inter-Poll is not an editing-intensive 
application, and most program input will be performed without 
editing. 

Editing can be performed only on text you type in, not text listed by 
the Inter-Poll search function (such as the device list). The Edit 
menu commands are described briefly in the next sections. 

Cut 
To use the Cut command, select the text to be deleted and then 
choose Cut from the Edit menu. The cut text will disappear from the 
screen and be placed in the Macintosh Clipboard. 

The cut text remains in the Clipboard until you choose Cut or Copy 
again; this will replace whatever is stored in the Clipboard. 

Copy 
To use the Copy command, select the text to be copied and then 
choose Copy from the Edit menu. The copied text will remain on 
the screen, but a duplicate copy of it will be placed in the Macintosh 
Clipboard. 

Paste 
Use the Paste command to retrieve whatever text was most recently 
stored in the Macintosh Clipboard. Position the pointer where you 
want the text to appear, and then choose Paste from the Edit menu. 
The contents of the Clipboard will appear after the pointer. 
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Appendix A 

AppleTalk Protocols 

This appendix is provided as a technical reference. Knowledge of 
AppleTalk protocol architecture is not required to understand or 
troubleshoot an AppleTalk network system. For more detailed 
information about AppleTalk protocols, see Inside AppleTalk. 

The AppleTalk protocols discussed in the following sections 
represent standardized conventions by which data is transferred 
among AppleTalk-compatible devices. The various protocols are 
applied to packet addressing, routing, device naming, file access 
and transfer, and other key functions of network communication. 
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As illustrated in the following figure, multiple AppleTalk protocols 
are combined in a hierarchical arrangement, where higher-level 
protocols use lower-level protocols to realize network activity goals. 

AppleTalk 
Filing 

Protocol (AFP) 

AppleTalk Zone AppleTalk Printer 
Data Stream Information Session Access 

Protocol (ADSP) Protocol (ZIP) Protocol (ASP) Protocol (PAP) 

L~ I I 
I I 

Routing Table Echo AppleTalk Name 
Maintenance Protocol (EP) Transaction Binding 

Protocol (RTMP) Protocol (ATP) Protocol (NBP) 

I I 
Datagram Delivery Protocol (DDP) 

I T 
EtherTalk AppleTalk 

Link Access Link Access 
Protocol (ElAP) Protocol (ALAP) 

Link Access Protocol (LAP) 
The primary function of a LAP is to manage node-to-node delivery 
of data on a single network. The particular LAP used depends on the 
cabling medium of the network. 

On a LocalTalk network, ALAP (AppleTalk Link Access Protocol) 
controls network access, manages data encapsulation into 
AppleTalk formats called frames, controls frame transmission and 
reception, and provides device identification and network 
addressing mechanisms. ALAP is replaced by ELAP (EtherTalk Link 
Access Protocol) in EtherTalk networks. 
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Datagram Delivery Protocol (DDP) 
DDP extends AppleTalk addressing beyond the node level through 
socket-to-socket delivery. This protocol defines internet addresses 
by socket number, node ID, and network number, and delivers data 
between individual sockets across an AppleTalk internet. 

Data packets routed by DDP are called datagrams. DDP 
determines the destination address of datagrams and builds the 
appropriate address headers onto data packets, to enable routing 
through internet bridges as required. 

Routing Table Maintenance Protocol (RTMP) 

RTMP provides the routing information required by bridges to 
route datagrams through bridge ports toward destination networks. 
The key element used to accomplish this is the routing table resident 
in each bridge. RTMP dynamically maintains routing tables to 
reflect changes in internet topology, and periodically updates all 
table entries. 

Echo Protocol (EP) 

EP is implemented as an echoer process at a particular AppleTalk 
address. This means it can be used to determine if the deSignated 
address is accessible over the internet. EP is also useful in 
determining the time required for a packet to reach its destination. 

Name Binding Protocol (NBP) 

NBP enables AppleTalk protocols to understand user-defined zones 
and device names, by providing and maintaining translation tables 
that map these names to corresponding socket addresses. 
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AppleTalk Transaction Protocol (ATP) 
An AppleTalk transaction takes place when a client of one socket 
transmits to another socket a request for which some response is 
required. (Generally, a status report or acknowledgment of the 
requested function is returned.) ATP manages this transaction in a 
way that binds the request and response together to ensure the 
reliable exchange of request/response pairs. 

AppleTalk Session Protocol (ASP) 
ASP provides a wider range of services than A TP for reliable 
transactions between higher-level protocols. This protocol can 
establish and maintain an AppleTalk session between two network 
resources. Within this session, a continuing exchange of AppleTalk 
transactions can take place between the participating devices. 

Printer Access Protocol (PAP) 
PAP manages interaction between workstations and print servers. 
This protocol handles connection setup, maintenance, and 
termination in addition to data transfer. 

Zone Information Protocol (ZIP) 
ZIP supports the AppleTalk zone feature by mapping zone names to 
corresponding network numbers. Zone Information Tables used in 
this function are implemented in all internet bridges and 
maintained by ZIP services. 

AppleTalk Filing Protocol (AFP) 
AFP allows dissimilar workstations to access a common me server. 
AFP supports Macintosh as well as MS-DOS, PC-DOS, and 
ProDOS® (Apple II family) system environments. This protocol is 
the me system language that governs shared access to the me server. 
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AppleTalk Data Stream Protocol (ADSP) 

ADSP is a connection-oriented protocol providing a reliable, 
full-duplex, byte-stream service between any two sockets on an 
AppleTalk internet. It ensures in-sequence, duplicate-free delivery 
of data over its connections. 
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Appendix B 

Network Configuration 
Guidelines 

The guidelines that follow apply to planning a new network as well as 
modifying an existing one. 

Network planning 
The prime concern in laying out a network system will be to 
maintain a long-term outlook: Will the network you create today be 
flexible enough to serve your changing needs in the future? Here are 
some of the key concepts to consider: 

• Avoid uncontrolled growth: Responsibility for network growth 
should be centralized with the network administrator. Users 
should not be permitted to add, remove, or relocate devices 
without consulting the network administrator. 

• Work toward a balanced network: The placement of shared 
services, such as LaserWriters, will cause areas of high traffic 
concentration on the network. Be sure to locate printers and 
servers in a way that balances traffic. 

• Avoid unnecessary through traffic: If one network is to 
require frequent access to one or more devices on another, be 
sure the networks are either contiguous or linked by a backbone. 
Otherwise, any networks placed between them will be bogged 
down carrying constant through traffic. 



• Use an orderly wiring scheme: When the cabling system is 
not well organized, or cables from different networks are not 
clearly distinguished, tasks such as troubleshooting or adding 
nodes become confusing and error-prone. It's a useful practice 
to label all cables clearly. 

• Control the assignment of zones and device names: 
Zones, network numbers, and device names should be kept 
consistent to facilitate network troubleshooting. Establish 
policies that centralize the planning and naming functions with 
the network administrator. 

Efficient network layout 
While every network is built to satisfy a different environment, some 
general guidelines can help optimize network layout. The sections 
that follow discuss the main considerations in designing an efficient 
network layout. 

Analyze user traffic needs 
LocalTalk hardware characteristics indicate a 32-node limit per 
single network; EtherTalk will support up to 254 nodes per network. 
Whether your situation will permit loading your network(s) to these 
limits, or expanding into an internet, will depend on the traffic 
generated by users. 

The usage level of any user can be classed as low, medium, or 
high. While no restrictive cutoff levels are specified for number of 
nodes per type of use, the analysis of usage levels will help you to 
balance network traffic. 

List users by level 

Make a list of anticipated network users, showing the expected usage 
level and network function (applications used) of each user, as in 
the example that follows on the next page. 
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User Function Usage Level 
Low Med High 

Mary Mail x 

William Mail, printing x 

Antoine Mail, file service, printing x 

Kelly Mail, printing x 

Steven Shared database x 

Penny Printing x 

Bob File service x 

Once users have been classed by usage level, compare network 
groupings with this list to see which groups are most likely to 
generate high traffic. Use this analysis to design a balanced network 
layout and to assign network resources to users. 

It would be unwise, for example, to group 32 high-usage 
workstations onto one network, unless the primary user function 
were file service or the network medium were Etheffalk. Likewise, it 
could be unnecessary and wasteful to break out 16 low-usage nodes 
into separate network segments with a bridge. A safe gUideline is to 
consider 16-20 medium-usage nodes (for example, printing and 
file service functions) to constitute a full network. 

.:. Note: It is good policy to underload networks in an initial 
internet design, since this will accommodate growth by adding to 
each network rather than creating additional networks. 

Allocate network services 
Once user traffic needs have been established, shared services such 
as LaserWriter printers and AppleShare file servers can be allocated 
for optimum efficiency. The location of a shared service should be 
selected to avoid unnecessary through traffic over networks that do 
not use the service. 

The number of users sharing a single service will, once again, be 
dictated by usage levels. AppleShare file servers use Macintosh hard 
disks, and are therefore also subject to disk size limitations. 
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In allocating shared printers, consider such factors as LaserWriter 
output speed and the number and size of printing jobs. Printing 
requirements will be unique to your situation and cannot follow any 
preset gUidelines. 

Redundant routing 
AppleTalk supports redundant routing in network system layouts. In 
this layout scheme, alternate paths are created between devices on 
an internet, providing a degree of fault tolerance in the event of a 
network break or bridge failure . Redundant routing requires an 
internet to contain at least two bridges, and to provide two or more 
routes between any two devices. 

The backbone decision 
When constructing an internet, the use of a backbone configuration 
can provide for higher performance in two ways: network 
independence and transmission speed. 

Network independence 
Consider the internet diagram below. Should a break occur on 
network C, networks A and B would no longer be able to 
communicate with networks D and E. This is one of the weaknesses 
of a linear internet layout. 

c D E 
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A 

If a backbone is introduced into this configuration, each network 
can now access the balance of the internet independently of any 
other network. The backbone serves as the common link. 

B c D E 

Transmission speed 
The AppleTalk network architecture uses a set of protocols that are 
not dependent on any single cabling specification or speed. Several 
cabling options exist for both local segments and backbones. You 
can use one or more of these alternatives in an AppleTalk network 
system. 

In a backbone internet that supports high internetwork traffic, a 
backbone cable medium with high bandwidth (throughput 
capacity), such as Ethernet, can significantly improve overall 
network speed. 

The backbone medium decision will involve cost and building 
installation considerations, and will require specific bridge or 
gateway hardware and software support. Consult your authorized 
Apple dealer or representative for guidance. 

88 Appendix B: Network Configuration Guidelines 



A 

Add button (Network Search 
window) 58 

additional parameters (Network 
Search window) 60 

addressing (AppleTalk) 7 
Administration disk 15 
ADSP (AppleTalk Data Stream 

Protocol) 83 
AFP (AppleTalk Filing Protocol) 82 
ALAP (AppleTalk Link Access 

Protocol) 80 
aliases, defined 64 
All Named Devices option (Network 

Search window) 58 
AppleTalk 

addressing 7 
bridges 8--10 
concepts and terminology 6-11 
internet address, defined 8 
protocols 79-83 

AppleTalk Data Stream Protocol 
(ADSP) 83 

AppleTalk Filing Protocol (AFP) 82 
AppleTalk Link Access Protocol 

(ALAP) 80 
AppleTalk Session Protocol (ASP) 

82 
AppleTalk Transaction Protocol 

(ATP) 82 
ASP (AppleTalk Session Protocol) 

82 
Async Count 74 
Async Interval 74 
ATP (AppleTalk Transaction 

Protocol) 82 

Index 

8 
backbone 87-88 

bridge, defined 10 
breaks 

internet, example of 53-54 
locating 21 
in network connections, 

troubleshooting 39 
bridges (AppleTalk). 

backbone 10 
defined 8--10 
local 9 
remote 9 

bus, defined 40 

C 
cable 

damaged, troubleshooting 40 
severed, troubleshooting 39 

cable extenders 
disconnected, troubleshooting 

39 
loose, troubleshooting 40 

cable termination 40-41 
cabling systems 6 
changing column width (Device List 

window) 62 
checking 

hop count 45 
internet 47 
lost packets 45 
network paths 44 
networks 43 
workgroup 47 
zones 42 

Clear All button (Network Search 
window) 59 

Clear button (Device Test window) 
69 

Clear button (Network Search 
window) 59 

Clipboard 77 
columns (Device List window) 62 
commands. See specific command 
configuration guidelines/planning 

(network) 5-6, 84-88 
Confirm Interval 74 
connections, troubleshooting 

39-40 
connector box 

break at, troubleshooting 39 
loose, troubleshooting 40 

Continuous time option (Network 
Search window) 57 

Copy command (Edit menu) 77 
copying Network Map file 17 
Cut command (Edit menu) 77 

D 

Datagram Delivery Protocol (DDP) 
81 

datagrams, defined 81 
DDP (Datagram Delivery Protocol) 

81 
Delay (Device Test window) 68 
deleting columns (Device List 

window) 62 
device list 20 

displaying 23-24 
printing 25 
saving 25 

89 



Device List Columns .command 
(Options menu) 63-{54 

Device List window 23- 24,61-{52 
formatting 24 

devices 
missing, troubleshooting 51 
named 7-8, 17 
testing 25-26, 44-45 
unnamed 8, 18, 59 

Devices Matching button (Network 
Search window) 58 

Device Test command (Special 
menu) 72-73 

Device Test window 44-45, 
66-{)9, 72-73 

dialog boxes. See specific dialog 
box 

displaying device list 23-24 
Done button (Device Test window) 

69 
driver 

E 

defined 38 
incompatibility, troubleshooting 

38 

Echo Interval 75 
echo packets 26, 67 
Echo Protocol (EP) 81 
Edit menu 77 
ELAP (EtherTalk Link Access 

Protocol) 80 
EP (Echo Protocol) 81 
Ethernet 88 
EtherTalk 6, 41 
EtherTalk Link Access Protocol 

(ELAP) 80 
EtberTalk User's Guide xii 
Exact Match button (Network 

Search window) 60 

F 

File menu 69-72 
Page Setup command 71 
Print Lists command 72 
Quit command 72 
Save List command 70-71 

90 Index 

Save Preferences command 
69-70 

Find Entry command (Options 
menu) 65 

Finder File Version button 75 
Find Same command (Options 

menu) 65 
floor plan. See network map; 

Network Map file 
formatting Device List window 24 
frames , defined 80 

G 

gateway, defined 10 
Get System Info button 76 
Get System Info command (Special 

menu) 75-76 

H 

hardware 
requirements xi-xii 
troubleshooting 39-40 

hexadecimal numbers 64 
hop, defined 10 
hop count, checking 45 
Hops Away (Device Test window) 

68 

I, J, K 

Inside AppleTalk xii 
installing 

Inter.Poll 15-17 
Responder 16-17 

intermittent connections, 
troubleshooting 40 

intermittent loss of network 
service, troubleshooting 52 

Internal Settings dialog box 73-75 
internet 

address (AppleTalk) 8 
break, example of 53-54 
checking 47 
defined 8 

Inter.Poll Workstation button 76 
Interval (Device Test window) 66 

L 

LAP (Link Access Protocol) 80 
LaserWriter drivers 38 
LaserWriter Driver Version 76 
layout (network) 85-87 
Link Access Protocol (LAP) 80 
List Aliases command (Options 

menu) 64 
List Using Hexadecimal Numbers 

command (Options menu) 64 
local bridge, defined 9 
LocalTalk 6, 41 
The LocalTalk Cable System Guide 

xii 
locating breaks 21 
long packets 67 
Lookup Interval 74 
lookup interval and count 73-74 
loop back tests 25-26, 45 , 66 

setting ranges 66 
lost packets, checking 45, 68 

M 

MacDraw. See network map; 
Network Map file 

maintenance 42-45. See also 
troubleshooting 

Match option (Network Search 
window) 59 

match parameters (Network Search 
window) 59 

match qualifiers (Network Search 
window) 60 

menus/ menu commands. See 
specific menu/menu command 

missing device , troubleshooting 51 
missing network, troubleshooting 

50 
missing zone, troubleshooting 

48-49 
moving columns (Device List 

window) 62 

N 

Name (column heading) 24 
Name Binding Protocol (NBP) 17, 

81 



named device 17 
defined 7-8 

Name option (Network Search 
window) 59 

NBP (Name Binding Protocol) 17, 
81 

Net (column heading) 24 
Net option (Network Search 

window) 59 
network 

checking 43 
configuration guidelines/planning 

5--6, 84-88 
missing, troubleshooting 50 

network administrator, selecting 
14-15 

network connections. See 
connections 

network devices 17. See also 
named devices; unnamed 
devices 

network maintenance. See 
maintenance 

network map 21, 28-33. See also 
Network Map file 

components 28 
creating 29-31 
examples of 31-33 

Network Map file 28. See also 
network map 

copying 17 
network number, defined 8 
network paths, checking 44 
Network Search command (Options 

menu) 63 
Network Search window 19, 

22-23, 56--61 
network service, intermittent loss 

of, troubleshooting 52 
network troubleshooting. See 

trou bleshooting 
node,defined 7 
Node (column heading) 24 
node and floor plan layout 32. See 

also network map 
node ID, defined 7 
Node Installation disk 15 

o 
Options menu 63--65 

p 

Device List Columns command 
63--64 

Find Entry command 65 
Find Same command 65 
List Aliases command 64 
List Using Hexadecimal Numbers 

command 64 
Network Search command 63 

packets 
defined 7 
lost 45 
types 67 

Packets (Device Test window) 
66--68 

Left 68 
Lost 68 
Received 68 
Total 68 

Packets Sent (Device Test window) 
68 

Page Setup command (File menu) 
71 

Page Setup dialog box 71 
PAP (Printer Access Protocol) 82 
parameters (Network Search 

window) 60 
Partial Match button (Network 

Search window) 60 
Paste command (Edit menu) 77 
planning (network) 84-85 
preventive maintenance. See 

maintenance 
Print dialog box 72 
Printer Access Protocol (PAP) 82 
printer packets 26, 67 
printing 

device list 25 
errors, troubleshooting 38 

Print Lists command (File menu) 
72 

problems. See troubleshooting 
protocols 79-83 

defined 6 

Q 

Quit command (File menu) 72 
quitting Inter.Poll 56 

R 

redundant routing 87 
reference pop-up menu (Network 

Search window) 60 
remote bridge, defined 9 
requirements xi-xii 
Responder 7-8 

installing 16-17 
routing, redundant 87 
routing table, defined 11 
Routing Table Maintenance Protocol 

(RTMP) 81 
RTMP (Routing Table Maintenance 

Protocol) 81 

5 

Save As dialog box 70-71 
Save List command (File menu) 

70-71 
Save Preferences command (File 

menu) 69-70 
Save Preferences dialog box 

69-70 
saving device list 25 
search, stopping/starting 62 
search criteria 58--60 

defined 22- 23 
Search Time (Network Search 

window) 57 
Select Sorting (Network Search 

window) 58 
Select Zone (Network Search 

window) 57 
Settings command (Special menu) 

73-75 
short packets 67 
skeleton network layout 33. See 

also network map 
Socket (column heading) 24 
sockets, defined 7 
software 

requirements xii 
troubleshooting 37-38 
version incompatibility 38 

Index 91 



sort order (Network Search window) 
58 

Special menu 72-76 
Device Test command 72-73 
Get System Info command 

75-76 
Settings command 73-75 

speed 6,88 
Start button (Device List window) 

62 
Start button (Device Test window) 

69 
Start button (Network Search 

window) 61 
starting Inter.Poll 19, 56 
Stop button (Device List window) 

62 
Stop button (Device Test window) 

69 
Sync Count 74 
Sync Interval 74 
System File Version 75 
system information 24-25 
system information packets 26, 67 
System Information window 75-76 
system requirements xi-xii 
system software, version 

T 

inconsistency, troubleshooting 
37-38 

testing devices 25-26, 44-45 
test packets 25-26 
Timeout (Device Test window) 66 
timeout period 45 
transmission speed 88 
troubleshooting 46-54. See also 

maintenance 
basic 36-41, 46 
network 4-5 
strategy 47-48 

Type (column heading) 24 
Type option (Network Search 

window) 59 

92 Index 

u, V 

unnamed device 18, 59 
defined 8 

Unnamed Interval 75 
Unnamed option (Network Search 

window) 59 
usage level, defined 85 
User Name 7-8, 16-17 

w, X, Y 

windows. See specific window 
With qualifier (Network Search 

window) 60 
workgroup, checking 47 

Z 

ZIP (Zone Information Protocol) 
82 

zone 57 
checking 42 
defined 8 
missing, troubleshooting 48-49 

Zone (column heading) 24 
Zone Information Protocol (ZIP) 

82 



THE APPLE PUBLISHING SYSTEM 

This Apple® manual was written, 
edited, and composed on a 
desktop publishing system using 
Apple Macintosh® computers 
and Microsoft® Word. Proof 
pages were created on the Apple 
LaserWriter® Plus; final pages 
were printed on a Varityper® 
VT6oo™. POSTSCRIPT®, the 
LaserWriter page-description 
language, was developed by 
Adobe Systems Incorporated. 
Some of the illustrations were 
created using Adobe 
Illustrator™. 

Text type is ITC Garamond® 
(a downloadable font distributed 
by Adobe Systems). Display type 
is ITC Avant Garde Gothic®. 
Bullets are ITC Zapf Dingbats®. 
Some elements, such as program 
listings, are set in Apple Courier, 
a fixed-width font. 



Apple Computer, Inc. 
20525 Mariani Avenue 
Cupertino, California 95014 
(408) 996-1010 
1lX 171-576 

030-2158-A 
Printed in U.SA. 



Apple$ Inter.PolLM Network 
Administrator's Utility 

Packing List 

This package contains the following items: 

3 

1 

Disks: ' Inter.PollT'" Network Administrator's Application 
Inter.PoW'" Responder Workstatton Installer 

(for the Macintosh 512K and 512XL) 
Inter.PoW'" Responder Workstatton Installer 

(for the Macintosh 512Ke, Plus, SE, and II) 

Manual: Inter.PollT'" Network Administrator's Guide 
(with Tell Apple card inserted in the manual) 

If you have any questions, please contact your authorized Apple dealer. 

030-2164-A 

690-5211 
690-5212 

690-52,29 

030-2158 
030-2159 

3/7/88 



Apple® InterePolrM 1.0.1 
Update 
Hardware and Software Compatibility 

The following changes pertain to Inter- PollTM version 1.0.1: 

1. Inter-Poll is now compatible with the Macintosh@ llx and Macintosh SE/30 computers. 

2. The version of the Responder™ Workstation Installer included on the enclosed disks identifies 
the Macintosh IIx and the Macintosh SE/30 accurately. Replace prior versions of Responder if 
necessary. 

3. System 6.0.3 has replaced System 4.3. 

4. The Inter-Poll network map symbols are now included in PICT format, which will allow the 
network map files to be opened by a wide range of applications, including MacDraw. 

Copyright 1991 by Apple Computer, Inc. 

Apple, the Apple logo, and Macintosh are registered trademarks of Apple Computer, Inc. 

Inter· Poll is a trademark of Apple Computer, Inc. 

MacDraw is a registered trademark of Cl.ARlS Corporation. 

031-1011 



.~ Apple~ Software Disk 
License Agreement 



PLEASE READ 1HIS DOCUMENf CAREFULLY 
BEFORE USING THE ENCLOSED SOF1W ARE. 
BY USING 1HE SOF1WARE, YOU AGREE TO 
BECOME BOUND BY THE TERMS OF 1HIS 
AGREEMENT, WHICH INCLUDES THE 
SOF1W ARE UCENSE AND DISCLAIMER OF 
WARRANIY. IF YOU DO NOT AGREE TO THE 
TERMS OF THIS AGREEMENT, DO NOT USE 
THE SOF1W ARE AND PROMPTLY RETURN 
THE PACKAGE TO THE PLACE WHERE YOU 
OBTAINED IT FOR A FULL REFUND. 

The enclosed Inter.Poli Application Software 
and Responder Workstation Installer Software 
programs are licensed, not sold, to you for use 
only upon the terms of this license, and Apple 
reserves any rights not expressly granted to you. 
You own the disks on which these programs are 
originally or subsequently recorded or ftxed, but 
Apple retains ownership of all copies of the 
programs themselves. 

1. License. This license allows you to: 

(a) Use the Inter.Poll Application Software only on 
one (1) Macintosh computer at a time. You are not 
authorized to make any copies of the Inter.Poll 
Application Software, except to make one working 
copy in machine readable forin for backup 
purposes. The Inter.Poll Application Software 
is protected by United States copyright law. You 
must reproduce on the backup copy the Apple 
copyright notice and any other proprietary 
legends that were on the original copy supplied 
by Apple. 

(b) Copy the Responder Workstation Installer 
Software to create startup disks for each Macintosh 
on your AppieTalk network so that the computer 
can be identifted by the Inter.Poll Application 
Software. 

(c) Transfer the Apple Software and all rights 
under this license to another party together with 
a copy of this Agreement provided you give 
Apple written notice of the transfer and the other 

party reads and agrees to accept the terms and 
conditions of this Agreement. 

2. Restrictions. You may not distribute copies of 
the Inter.Poll Application Software to others or 
electronically transfer the Inter.Poll Application 
Software from one computer to another over a 
network. The Inter.Poll Application Software 
contains trade secrets and to protect them 
you may not decompile, reverse engineer, 
disassemble or otherwise reduce the Inter.Poll 
Application Software to a human perceivable 
form. YOU MAY NOT MODIFY, ADAPT, 
TRANSLATE, RENT, LEASE, LOAN, RESELL FOR 
PROFIT, DISTRIBUTE, NE1WORK OR CREATE 
DERIVATIVE WORKS BASED UPON THE 
INTER.POLL APPUCATION SOFIWARE OR ANY 
PART TIIEREOF. 

3. Termination. This License is effective 
until terminated. This License will terminate 
automatically without notice from Apple if 
you fail to comply with any provision of this 

~~------------~--~ License. pan ternunation you must stroy 
the Inter.Poll Application Software and all copies 
thereof. You may terminate this License at any 
time by destroying the Inter.Poll Application 
Software and all copies thereof. 

4. Export Law Assurances. You agree and certify 
that neither the Inter.Poli Application Software 
nor any direct product thereof is being or will be 
shipped, transferred or reexported, directly or 
indirectly, into any country prohibited by the 
United States Export Administration Act and the 
regulations thereunder or will be Used for any 
purpose prohibited by the same. 

5. Government End Users. If the Inter.Poli 
Application Software is acquired by or on behalf of 
a unit or agency of the United States Government 
this provision applies. This Inter.Poli Application 
Software: (a) was developed at private expense, 
and no part of it was developed with government 
funds, (b) is a trade secret of Apple for all 
purposes of the Freedom of Information Act, 



(c) is "commercial computer software" subject to 
limited utilization as provided in the contract 
between the vendor and the governmental entity 
and (d) in all respects is proprietary data 
belonging solely to Apple Computer, Inc. 

For units of the Department of Defense (DoD), 
this Inter.Poll Application Software is sold only 
with "Restricted Rights" as that term is defIned in 
the DoD Supplement to the Federal Acquisition 
Regulations, 52.227-7013 (b) (3) (ii) and: 

Use, duplication or disclosure is subject to 
restrictions as set forth in subdivision (b) (3) (ii) 
of the Rights in Technical Data and Computer 
Software clause at 52.227-7013. Manufacturer: 
Apple Computer, Inc., 20525 Mariani Avenue, 
Cupertino, California 95014. 

If this Inter.Poll Application Software was 
acquired under a GSA Schedule the Government 
has agreed to refrain from changing or removing 
any insignia or lettering from the Software or 

FOR LOSS OF BUSINESS PROFITS, BUSINESS 
INTERRUPTION, LOSS OF BUSINESS 
INFORMATION, AND THE liKE) ARISING 
OUT OF TIm USE OF OR INABIll1Y TO USE 
THE APPLE SOFTWARE EVEN IF APPLE OR 
AN AUTIIORIZED APPLE REPRESENTATIVE 
HAS BEEN ADVISED OF THE POSSIBIU1Y OF 
SUCH DAMAGES, OR FOR ANY CLAIM BY 
ANY OTHER PAR1Y. 

BECAUSE SOME STATES DO NOT AllOW THE 
EXCLUSION OR UMITATION OF UABIUTY FOR 
CONSEQUENTIAL OR INCIDENTAL DAMAGES, 
THE ABOVE UMITATIONS MAY NOT APPLY TO 
YOU. 

Apple's liability to you for actual damages for any 
cause whatsoever, and regardless of the form of 
the action, will be limited to the greater of $50 or 
the money paid for the software that caused the 
damages. 

7. General. This Agreement will be construed 
the documentation that is provided or from 
producing copies of manuals or disks (except 
one copy for bac:la.lp-p~sl,and: _ 
(1) Title to and ownership of this ~oftware and 
documentation and any reproductions thereof 
shall remain with Apple Computer, Inc.; 

_ under the laws o£ the state of California, excel2L 
for that body of law dealing with conflicts of law. 
If any provisio~ of this Agreement shall be held 

(2) Use of this Software and documentation shall 
be limited to the facility for which it is acquired; 
and 
(3) If use of the Software is discontinued to the 
installation specified in the purchase/delivery 
order and the Government desires to use it at 
another location, it may do so by giving prior 
written notice to Apple Computer, Inc., specifying 
the type of computer and new location site. 

Governmental personnel using this Apple 
Software, other than under a DoD contract or 
GSA Schedule, are hereby on notice that use of 
this Software is subject to restrictions which are 
the same as or similar to those specilled above. 

6. Umitation of Remedies and Damages. 
IN NO EVENT WIlL APPLE BE LIABLE TO YOU 
FOR ANY CONSEQUENTIAL, INCIDENTAL OR 
INDIRECT DAMAGES ONCLUDING DAMAGES 

by a court of competent jurisdiction to be contrary 
to law, that provision will be enforced to the 
maximum extent permissible, and the remaining 
provisions of this Agreement will remain in full 
force and effect 

LIMITED WARRANTY AND LIMITATIONS 
ONWARRANlY 

A. Umited Warranty on Media. Apple warrants 
the diskettes on which the Apple Software is 
recorded to be free from defects in materials and 
faulty workmanship under normal use for a period 
of ninety (90) days from the date of delivery as 
evidenced by a copy of the receipt Apple will, at 
its option, replace or refund the purchase price 
of the diskette at no charge to you, provided you 
return the faulty diskette with proof of purchase 
to Apple or an authorized Apple dealer. Apple 
shall have no responsibility to replace or refund 



the purchase price ofa diskette damaged by 
accident, abuse or misapplication. ANY IMPIlED 
WARRANTIES ON THE DISKETTES, INCLUDING 
IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FI1NESS FOR A PARTICULAR PURPOSE, 
ARE LIMITED IN DURATION TO 90 DAYS FROM 
THE DATE OF DELIVERY. 

B. DJsclaimer of Warranty and Limlted 
Warranty. 1HE APPLE SOF1W ARE IS 
PROVIDED."AS IS" WI1HOUT WARRANTY OF 
ANY KIND, AND APPLE EXPRESSLY DISCLAIMS 
ALI. IMPLIED WARRANTIES, INCLUDING BUT 
NOT LIMITED TO THE IMPIlED WARRANTIES 
OF MERCHANTABIIlTY AND FI1NESS FOR 
A PARTICULAR PURPOSE. APPLE DOES NOT 
WARRANT, GUARANTEE, OR MAKE ANY 
REPRESENTATIONS REGARDING THE USE, 
OR THE RESULTS OF THE USE, OF THE APPLE 
SOF)W ARE IN TERMS OF CORRECTNESS, 
ACCURACY, RELIABILITY, CURRENTNESS, 
OR OTHERWISE. THE ENTIRE RISK AS TO THE 
RESULTS AND PERFORMANCE OF THE APPLE 
SOF1WARE IS ASSUMED BY YOU. APPLE DOES 
NOT WARRANT THAT THE APPLE SOF1WARE 

WILL WORK CORRECTI.Y IN A MULTI-USER 
ENVIRONMENT. IF 1HE APPLE SOF1W ARE 
IS DEFECTIVE, YOU, AND NOT APPLE OR 
ITS DEALERS, DISTRIBUTORS, AGENTS, OR 
EMPLOYEES, ASSUME THE ENTIRE COST 
OF ALI. NECESSARY SERVICING, REPAIR, OR 
CORRECTION. SOME STATES DO NOT ALLOW 
THE EXCLUSION OF IMPLIED WARRANTIES, 
SO THE ABOVE EXCLUSION MAY NOT APPLY 
TO YOU. 

C. Umltations of Warranty. THE LIMITED 
WARRANTIES PROVIDED IN PARAGRAPHS A 
AND B ABOVE ARE THE ONLY WARRANTIES 
OF ANY KIND THAT ARE MADE BY APPLE ON 
THIS APPLE PRODUCT. NO ORAL OR WRITTEN 
INFORMATION OR ADVICE GIVEN BY APPLE, 
ITS DEALERS, DISTRIBUTORS, AGENTS, OR 
EMPLOYEES SHALL CREATE A WARRANTY 
OR IN ANY WAY INCREASE THE SCOPE OF 
THIS WARRANTY, AND YOU MAY NOT RELY 
ON ANY SUCH INFORMATION OR ADVICE. 
THIS WARRANTY GIVES YOU SPECIFIC LEGAL 
RIGHTS. YOU MAY HAVE OTHER RIGHTS, 
WHICH VARY FROM STATE TO STATE. 
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Release 1.0.1 

Inter-Poll gives network administrators the 
software tools needed to implement a support 
program for Apple7alk® network systems. 
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Apple® Inter-PollT. 
Network Administrator's Utility 
Inter-Poll provides a set of tools that help network 
administrators to manage their AppleTalk® network 
systems more efficiently and to provide greater 
network reliability for their users. 

Inter-Poll consists of three parts. 
1) Administrator's Application: This is a Macintosh® 

application that finds and displays all active devices, or 
a subset as defined by search criteria. 

2) Network Mapping Symbols: This is a MacDraw file 
that contains symbols for network devices and san1ple 
floor plans that help the network administrator to build 
an accurate network map and to keep it current. 

3) Administrator's Guide: This document provides 
an overview of AppleTalk networking concepts, and 
outlines a program of network administration. 

Inter-Poll gives the network administrator these 
benefits: 

• Provides a view of the entire AppleTaIk internetwork 
from a single location: Inter-Poll lets the network 
administrator view and test the path to all devices on the 
network from his or her workstation. This allows the 
administrator to begin to diagnose a fault without having 
to manually inspect the entire internet. 

• Helps to eliminate problems caused by incompatible 
network system software: Inter-Poll lets the network 
administrator list and compare system software versions 
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on any group of Macintosh computers on the internet
work. Devices that have incompatible versions are 
quickly identified. 

• Minimizes training and enhances efficiency: 
Inter-Poll takes full advantage of the Macintosh user 
interface to provide a program that an administrator can 
learn quickly and use efficiently 

• Supports a mixed-vendor AppleTaIk network system: 
Inter-Poll supports devices on all AppleTalk network 
systems, including LocalTalk'" and EtherTalk:" 
Macintosh (with 512K RAM or greater), Apple ile/IlGs, 
and MS-DOS PC workstations are all recognized by 
Inter-Poll, as well as AppleTalk servers including 
AppleShare,® LaserShare,'· and AppleTalk servers on 
DEC VAXIVMS S\-stem _ 

Required Equipment: 
Inter·Poli Net\\-ork Administrator's Application can be run on the 
following computers: 
• Macintosh Plus 
• Macintosh SE 
• Macintosh II 

© 1988 Apple Computer. Inc. Apple. the Apple logo, AppleShare, AppleTalk, LaserWriter, and 
Macintosh are registered trademarks of Apple Computer, Inc. EilierTaik, Inter-Poll, LaserShare, 
and LocaiTaik are trademarks of Apple Computer, Inc. DEC, VA:'\., and VMS are registered 
trademarks ofDigitai Equipment Corporation. ~ lacDraw is a registered trademark of 
Claris Corporation. MS-DOS is a registered trademark of Microsoft Corporation. 
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